Scenario 360
Tutorials

SiteBuilder 3D by MultiGen-Paradigm
# Table of Contents

**Scenario 360 tutorials**

Before you begin ........................................................................................................... 1

**Tutorial 1 – Integrated analysis using decision tools** .................................................... 2

Starting the tutorial ........................................................................................................... 2

Setting up a suitability analysis ....................................................................................... 2

  Specifying new suitability factors .................................................................................. 4

Running the suitability analysis ....................................................................................... 5

Viewing the results of your analysis .................................................................................. 6

Completing your suitability analysis .................................................................................. 8

Setting up a build-out analysis ......................................................................................... 8

  Opening the Build-Out Wizard ...................................................................................... 9

Setting up a numeric build-out analysis .......................................................................... 9

  Specifying land-use information ................................................................................... 9

  Setting up density rules ............................................................................................... 10

  Mixed-Use Percentages ............................................................................................... 10

  Using efficiency factors ............................................................................................. 10

  Entering building information .................................................................................... 10

  Specifying constraints to development and existing buildings .................................. 10

  Completing the numeric build-out phase .................................................................... 11

Setting up a spatial build-out analysis .......................................................................... 11

  Specifying building separation distances and choosing a layout pattern .................. 11

  Running a spatial build-out analysis .......................................................................... 12

Setting up a TimeScope analysis .................................................................................. 12

  Setting up TimeScope for a layer .............................................................................. 13

Experiment with the TimeScope Time assumption ....................................................... 14

Setting up a common impacts analysis ......................................................................... 15

Examining the common impacts results ........................................................................ 16

  Reviewing the Common Impacts report ..................................................................... 17

Active content in reports ............................................................................................... 17

Congratulations – you have completed Tutorial 1 ......................................................... 18

**Tutorial 2 – Explore an existing scenario** ................................................................. 19

Suitability and cost analysis of rural residential vs. village development ...................... 19

Starting the tutorial ........................................................................................................... 19

Working with ArcMap ..................................................................................................... 20

  Working with toolbars in ArcMap ................................................................................ 21

  The ArcMap table of contents ................................................................................. 21

  The ArcMap map view ............................................................................................. 21

Viewing charts .................................................................................................................. 22

Working with assumptions ............................................................................................. 23

  Changing assumptions for the acceptable distance to the nesting area ..................... 23

  Changing assumptions to prohibit building on wetlands .......................................... 25

Working with the ArcMap map view .............................................................................. 26

  Moving features in the map view to change suitability .............................................. 26

  Changing water tank location assumptions to determine water pressure suitability .... 27

Running a road cost analysis .......................................................................................... 28

  Evaluating road costs by experimenting with changing the road type ..................... 28

Comparing scenarios ....................................................................................................... 31

  Scenario comparison features ................................................................................... 32

Working with CommunityViz sharable 3D scenes .......................................................... 32

  Moving around in 3D ................................................................................................. 32

  Displaying features ................................................................................................... 33

Adding environmental effects ......................................................................................... 33

Scenario 360 Sketch Tools and Land-Use Designer .......................................................... 33

  Opening and setting up the data ................................................................................ 33
### Tutorial 3 – Setting up and running an analysis

**Starting a new analysis**

- Prepare your data
- Common projected coordinate systems
- How to define a coverage's coordinate system

**Adding data**

- Adding existing data layers
- Adding a new empty data layer

**Working with 360 Setup tab**

- Creating a new category
- Reordering categories

**Creating assumptions**

- Creating the Residential Ratio variable assumption
- Creating the Retail Ratio variable assumption
- Creating the Office Ratio variable assumption
- Editing assumptions (optional)

**Creating dynamic attributes and associated formulas**

- Dynamic attribute formulas

**Creating an alert**

- Testing your new formula and alert

**Using the Formula Wizard to create a dynamic attribute**

- Calculating office area
- Duplicating a dynamic attribute to calculate retail area
- Copying a formula to calculate residential area

**Creating a new chart**

### Tutorial 3b – Advanced setup and analysis

**Creating a lookup table**

**Editing attributes**

**Creating a variable assumption**

**Creating dynamic attributes using information from a lookup table**

- Creating the Office and Retail Employees dynamic attributes
- Creating the Dwelling Units dynamic attribute
- Creating the Population dynamic attribute
- Creating the Construction Cost dynamic attribute

**Creating indicators and alerts**

- Creating the Population indicator
- Creating the Employees indicator
- Creating the Construction Cost indicator and alert

**Creating and editing indicator charts**

- Creating a chart with a threshold line to track the total cost of construction
- Adding an item line to the chart
- Editing the Population chart

**Experimenting with assumptions**

- Adding new buildings and modifying building stories

**Viewing a diagram of the analysis components and relationships**

**Viewing this analysis in 3D**

**Exploring further**

**Congratulations – you have completed Tutorial 3**

### Tutorial 4 – Working with SiteBuilder 3D
**Scenario 360 tutorials**

These CommunityViz tutorials provide tutorial instructions aimed at familiarizing you with the procedures and concepts necessary for working with Scenario 360, SiteBuilder 3D and related tools like Google Earth. These tutorials are just fictional examples, and although they represent realistic decisions that people face every day, the data and assumptions used are simply for illustration. The analyses have no “right” answers and are not meant to imply any bias on any of the issues considered.

There are seven tutorials. Tutorial 1 gives a broad overview of capabilities, and Tutorial 2 introduces some basic concepts in more detail. If you are new to ArcGIS, you may prefer to start with Tutorial 2 and then return to Tutorial 1 before proceeding through the other tutorials.

- **Tutorial 1** – This tutorial gives you an overview of the capabilities of Scenario 360 by applying "decision tools" (Suitability, Build-Out, TimeScope, and Common Impacts Wizards) in combination with one another to create a comprehensive growth analysis.
- **Tutorial 2** - Explore an existing analysis. This tutorial uses two scenarios (rural and village type development options) to walk you through investigating variables that affect development suitability and road construction cost models. You also learn how to create a new scenario by painting or cloning other land-use types with Scenario 360 Sketch Tools and the Land Use Designer.
- **Tutorial 3** – Set up your own analysis. This tutorial will walk you through creation of a cost analysis in an urban environment.
- **Tutorial 4** – Create and work with a SiteBuilder 3D scene. This tutorial will walk you through the creation of a 3D scene, including terrain and textures. You can then “fly” around and through the landscape and its features.
- **Tutorial 5** – Run a Build-Out analysis. This tutorial will walk you through setting up and running a more detailed numeric, spatial, and visual build-out than you did in Tutorial 1.
- **Tutorial 6** - Run an analysis and create presentations. This tutorial will walk you through displaying analysis information, creating saved views, comparing scenarios, and creating web-ready reports and analyses.
- **Tutorial 7** - Export your analysis to Google Earth and display different TimeScope build dates in the 3D world of Google Earth.

Remember that these tutorials represent only a subset of what is possible in Scenario 360 and CommunityViz.

**Before you begin**

- **Have a working knowledge of ArcMap** – The Scenario 360 tutorials assume that you have a working knowledge of ArcMap. For assistance with ArcMap and ArcGIS tools, see the ArcGIS help.
- **Install Scenario 360** - Install Scenario 360 and SiteBuilder 3D. Activate your license using the License Activation Wizard. For detailed instruction on installing Scenario 360 and SiteBuilder 3D, refer to the installation instructions provided in the Scenario 360 software package.
- **Install the tutorial data** - The data required to use the Scenario 360 tutorials is provided on the Scenario 360 Resource Disk that shipped with your Scenario 360 software.
  1. Load the CommunityViz Resource Disk in your CD drive.
  2. Navigate to the Tutorials directory and double-click Tutorial Installer.exe to automatically load the tutorial data into the CVFiles directory on your computer.
- **Print these instructions.** If desired, print a paper copy of these instructions to use as you work through the tutorials.
- **Use the Quick Reference Guide for reference and information on Scenario 360** - Utilize the Scenario 360 Quick Reference Guide to familiarize yourself with the Scenario 360 software features and functions and help provide information on and help with analytical tools as you go.
Tutorial 1 – Integrated analysis using decision tools

This tutorial will give you a good overview of the capabilities of Scenario 360 that are provided by the decision tools for community planning. This tutorial contains a series of exercises that demonstrate how to use the decision tools with one another in the course of a comprehensive growth analysis. It starts with a Suitability analysis that selects the best places to build, then follows with Build-Out and TimeScope to simulate the development itself. Finally, it uses the Common Impacts Wizard to evaluate some of the development’s effects.

The purpose of this tutorial is to provide some examples of how Scenario 360 decision tools can be used on their own or in combination with one another. The sequence we’ve chosen is just one example of the many ways you can use these modular components. The tutorial does not go into great detail on any of the individual decision tools, but it is intended to give you an idea of what each one can do and provide some examples of how they can be used together.

Once you have installed the tutorial data using the “Install the tutorial data” directions, you will find this analysis in the CVFiles\Sunny Vista folder.

**Objective**
- Rate the suitability and desirability of proposed building parcels in two different scenarios.
- Run a standard build-out analysis on each scenario.
- Estimate the order of building based on the desirability of each building location.
- Estimate the rate of building and visually illustrate growth over time using TimeScope.
- Estimate the impacts of building over time using the common impacts decision tool.

**Starting the tutorial**

1. Install the tutorials data from the Resource Disk that shipped with your software.
2. Start Scenario 360 by double-clicking on the Scenario 360 icon on your desktop.
3. Click Open Existing Analysis, browse to the CVFiles/Sunny Vista analysis, select it, and click OK. If asked about converting to a File Geodatabase, click YES.
4. Scenario 360 will load and display a fictional place called “Sunny Vista”. Sunny Vista is a high mountain site on the outskirts of a mountain town being considered for development.

**Setting up a suitability analysis**

The Scenario 360 suitability decision tool (the Suitability Wizard) helps you set up an analysis that scores geographic features based on their suitability or desirability for a particular application. For example, you can calculate which parcels are best for building, which tracts are most important to preserve, or which locations are most likely to attract retail business. (The same kind of analysis can be used for risk or vulnerability assessment, too.) These separate factors are rated independently and then combined to produce a final suitability score. Optionally, variable weights can be applied independently so that the final analysis places more importance on some factors and less on others.
1. You can access the Suitability Wizard using the Scenario 360 toolbar. Click the **Scenario 360** drop-down list and select **Tools > Suitability Wizard**.

2. Ensure the **Create a new suitability measure** radio-button option is selected.
3. Ensure **Parcels** is selected in the dropdown list of available dynamic layers.
4. Accept the default output name of **Suitability** and click **Next**.
Specifying new suitability factors

1. Click the **Create a new suitability factor** button.

2. Create a new **Suitability Factor** by specifying the factor name **Well Proximity**. Leave the default method as **Proximity to other features** and select the **Water Wells** layer from the dropdown list. Also leave in place the default setting that “Higher” scores result from closer proximity. These settings will create a suitability factor rating that is highest for parcels that are closest to wells and lowest for parcels that are furthest from wells.

3. Click **Next**.

4. Accept the default option to create a weighting assumption for this factor by clicking **Next** again at the **Variable Weighting** screen.

5. Now you will create another new factor that will contribute to the suitability measure for your parcels. Click the **Create a new suitability factor** button on the **Suitability Measure Summary** page.
6. Choose the **Amount of overlap with another layer** method and name this factor **Habitat Overlap**. Select the **Elk Grazing Habitat** layer from the drop-down list and specify that “Lower” scores result from more overlap.

7. Click **Next** then click **Next** again to accept the default option to create a weighting assumption for this factor.

8. **Optional Step** (Spatial Analyst extension needed): Create a third factor by repeating the steps above. Name this factor **Slope** and choose the **Average value of underlying grid** method. Select the **Slope** layer from the Specify Grid Layer drop-down list and “**Lower**” from the scores result drop-down list. This indicates that lower scores will result from higher grid values.

9. Click **Next** twice to accept the defaults as before, which will return you to the **Suitability Measure Summary** page.”

**Running the suitability analysis**

You have now created three factors. Each of these will contribute to the suitability rating for your parcels. The **Suitability Measure Summary** page should display the three factors you just created: **Well Proximity**, **Habitat Overlap** and **Slope**.
1. Ensure the option **Create a TimeScope phase attribute named ‘TimeScope Suitability’** is checked. This will create an attribute that is designed to work with the TimeScope. Its values will be lowest for the most suitable parcels and highest for the least suitable parcels. Later, you will use this attribute to cause TimeScope to build on the most suitable (and presumably most desirable) parcels first. (TimeScope always builds in order from lowest values to highest.)

![Suitability Wizard - 'Suitability' in layer 'Parcels'](#)

<table>
<thead>
<tr>
<th>Factor Name</th>
<th>Formula Type</th>
<th>Target Layer</th>
<th>Weighted?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Well Proximity</td>
<td>Proximity</td>
<td>Water Wells</td>
<td>Yes</td>
</tr>
<tr>
<td>Habitat Overlap</td>
<td>Overlap</td>
<td>Elk Grazing Habitat</td>
<td>Yes</td>
</tr>
<tr>
<td>Slope</td>
<td>Grad</td>
<td>Slope</td>
<td>Yes</td>
</tr>
</tbody>
</table>

To change or delete a factor, click on its name in the table.

- Create a chart comparing weights.
- Run analysis now.
- Run analysis every time inputs change.

2. You are now ready to run your suitability analysis. Click **Finish** and wait while the Suitability Wizard creates all the necessary analysis components and completes processing.

**Viewing the results of your analysis**

One way to view your results is to open the **Parcels** attribute table (right-click on the layer name in the ArcMap Table of Contents) and inspect the new field values. You’ll note that the Suitability attribute now has values between 0 (least suitable) and 100 (most suitable).

A more graphical way to view your suitability results is to adjust the symbology for your **Parcels** layer.

1. From the ArcMap Table of Contents, double-click the **Parcels** layer in the active scenario to open the Layer Properties dialog. From there, select the **Symbology** tab.
2. In the left-hand list, select **Quantities > Graduated colors**. Next, use the Value drop-down list to select the **Suitability** field. Choose a color ramp and a number of classes that meet your preference and click **OK**. Your map should now be symbolized by the results of your suitability.

![Layer Properties dialog box](image)

In the above example, the bright green represents the most suitable areas and the red the least suitable according to the three factors in your suitability measurement.

3. Switch the active scenario using the drop-down list on the **360 Analysis** tab to view the Proposal B.

4. Now you will explore the effects of changing the relative weight of each suitability factor. Open the **Assumptions** window by clicking the **Assumptions** button 🕵️‍♀️ on the **Scenario 360** toolbar.
5. Use the slider bars to adjust the weights associated with the three factors driving your suitability analysis (i.e., Well Proximity, Habitat Overlap and Slope), then click the Apply Assumption Changes button. The suitability results on the map will change dynamically based on your new settings.

**Completing your suitability analysis**

Once you finish reviewing your suitability results, make sure the slider bar values of your Suitability Assumptions are set to any interesting set of non-zero values. If the Apply Assumption Changes button is active (i.e., the checkmark icon appears green), click it to apply the current assumption values to your analysis. This ensures your Suitability measure contains varied results (which will be important later when you use these results to drive your TimeScope analysis).

**Setting up a build-out analysis**

The Scenario 360 build-out analysis tool (the Build-Out Wizard) automates the entire build-out process. It guides you through the choices and selections that will form the basis of your build-out analysis. In the fictional example of Sunny Vista, you will run a build-out analysis on a study area containing a few basic land-use designations:

- Commercial
- Mixed Use
- Single Family Residential
The land-use rules for this analysis are included in the table below. In this tutorial, you will be walked through entering this information into the Build-Out Wizard to run a numeric and spatial build-out analysis. For a more detailed breakdown of the steps involved in creating and running a build-out analysis, please see Tutorial 5 – Setting up and running a build-out analysis.

<table>
<thead>
<tr>
<th>Land-Use Designation</th>
<th>Density</th>
<th>Mixed Use</th>
<th>Building Info</th>
<th>Min Separation Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial</td>
<td>2 FAR</td>
<td></td>
<td>0 DU/Building 20000 sq. ft. 2 floors</td>
<td>20 feet</td>
</tr>
<tr>
<td>Mixed Use</td>
<td>2 FAR</td>
<td>Commercial = 50% Residential = 50% and 2000 sq. ft./DU</td>
<td>1 DU / Building 20000 sq. ft. 2 floors</td>
<td>20 feet</td>
</tr>
<tr>
<td>Single Family Residential</td>
<td>1 Number of DU</td>
<td>5000 sq. ft. 2 floors</td>
<td>20 feet</td>
<td></td>
</tr>
</tbody>
</table>

Opening the Build-Out Wizard
To begin, make sure Proposal A is the active scenario by selecting it from the drop-down list on the 360 Analysis tab (Build-Out for Proposal B has already been generated for your convenience).

Setting up a numeric build-out analysis
For a numeric build-out analysis, the Build-Out Wizard will calculate the estimated building capacity (in numbers) for each parcel. Note that at any time while you’re working with this Wizard, you may exit and retain your entered information by clicking the Save and Exit button at the bottom of the wizard.

1. Open the Build-Out Wizard. You can access the Build-Out Wizard using the Scenario 360 toolbar. Click the Scenario 360 drop-down list and select Tools › Build-Out Wizard.
2. Click the Numeric button.

Specifying land-use information
At the prompts on the first page of the numeric build-out, specify the following information:

1. On the Specify Land-Use Layer screen, ensure that Parcels is selected as the layer containing land use information.
2. The attribute specifying land-use designation should read Land_Use.
3. The attribute specifying the unique identifier of each land-use area should read OBJECTID_1.
4. Preview the land-use designations in the field provided then click Next.

Setting up density rules
Density is an indication of the number of buildings per unit area. For residential polygons, density is often provided in dwelling units per area (e.g., 2 units/acre), number of dwelling units, or minimum lot size per area. In this simple example, we’ll simply specify one building per residential parcel. For non-residential polygons, density is usually provided in floor area (e.g., 10,000 sq. ft.) or by using a floor area ratio (FAR). For this exercise:

1. Either type or click and select from a provided drop-down list to fill in the fields with the information shown in the image below:
2. Ensure the checkbox titled **One or more designations include mixed-use buildings** is not checked. (Build-out allows both residential and commercial buildings on one land-use polygon, as shown in this example, and mixed uses within single buildings. The latter is a more advanced capability not covered in this tutorial.)

3. Click **Next**.

### Mixed-Use Percentages

Because at least one of your land-use types mixes residential and commercial uses (i.e., has dwelling units and commercial floor area), the next screen, Mixed-Use Percentages, appears and gives you the option to specify more details. You may ignore this screen for now, accepting the default values and clicking **Next**.

### Using efficiency factors

Efficiency factors adjust density values to reflect common density losses. They are entered as a percentage where 100% means complete efficiency (no density lost), and 0% means no buildings will be estimated for that land use. On the **Efficiency** screen, leave the default setting of **Assume 100% efficiency** checked and click **Next**.

### Entering building information

The **Building Information** Wizard screen is optional. You may accept the defaults and click **Next**.

### Specifying constraints to development and existing buildings

Land-use regulations may prohibit building in certain areas, such as on rights-of-way or on protected lands such as endangered species habitat. In addition, some areas may be impractical for building because the area is too steep a slope or under water. If your analysis contains layers representing these unbuildable areas, which the wizard calls “constraint layers,” you can specify them here. For this example, highlight the layer called “Elk Grazing Habitat” and then click the right green arrow to move it into the list of Constraint Layers.
Some land-use regulations also specify a minimum lot size for new construction, but we will ignore that option here. Click Next, then click Next again to move past the Existing Buildings screen.

**Completing the numeric build-out phase**

You are now finished setting up the numeric phase of the build-out analysis. On the End of Numeric Phase Wizard screen, select Continue on to spatial build-out set up and click Next.

**Setting up a spatial build-out analysis**

Spatial build-out places potential new building points on a 2D map. It converts the numeric building counts into points representing individual structures, and it attempts (via computerized trial and error) to place those structures on the land without violating any land-use regulations about where buildings can go. In some cases, it finds it cannot place all the buildings specified by numeric build-out because of the geometry of land-use areas and buildings. For example, an oddly shaped lot may theoretically have enough total area for 2 buildings, but because of setback rules or minimum separation distances, it only may fit 1 unit. In this case, the number of “spatial” buildings is less than the number of “numeric” buildings, providing a more refined estimate of build-out capacity. You must first run a numeric build-out analysis (to get the numeric building counts) if you wish to run a spatial build-out analysis.

**Specifying building separation distances and choosing a layout pattern**

You have control over how far apart buildings need to be, whether the spatial build-out building points are distributed in a random or grid pattern, and if you want the points to follow a road layer.

1. Make sure the units drop-down list under **Minimum Separation Distance** has **feet** selected.
2. Make sure the units dropdown list under **Setback** has **feet** selected.
3. Using the information in the image below, type or click and select from a provided drop-down list to fill in the **Minimum Separation**, **Layout Pattern**, **Road or Line Layer**, and **Setback** fields.
4. Click **Next** twice.

### Running a spatial build-out analysis

1. Select the **Finalize set up of numeric and spatial build-out and continue to the next step** option.
2. Leave the slider bar at **100**. This is a small study area and will not take a long time to process.
3. Click **Next**. If it is showing, select the **Overwrite the current results** option. (This option doesn’t appear the first time you run a build-out.)
4. Make sure that only **Numeric** and **Spatial** are selected (they have a checkmark next to them) and click **Run Build-Out**.

You can monitor the progress of the processing by watching the status bar at the bottom of your screen. When the process completes, look for and turn on the Build-Out group of layers in the Table of Contents, including the **Buildable Area** layer and the **Buildings** layer. Notice that the Buildable Area layer is just like the original **Parcels** layer except that the Elk Grazing Habitat constraint layer has been cut out or “clipped.” It is also color-coded to illustrate the land-use designation for each area using standard planning conventions. If you open the attribute table for **Buildable Area**, you will see several fields containing useful information. The Buildings layer shows building points placed by spatial build-out. Note that none of the buildings lies on the constrained area, and notice how all the Single Family Residential buildings are the same distance from the nearest road.

For more details on your build-out analysis, open the Build-Out Report by clicking the **List Reports** button on the Scenario 360 toolbar and then clicking on the name of your build-out report.

### Setting up a TimeScope analysis

The Scenario 360 **TimeScope** decision tool helps you look at changes over time by allowing you to specify the rate and order that features will be built. The Wizard prompts you to enter data and assumptions that create a **TimeScope Time** variable assumption and apply TimeScope to one or more dynamic layers in your analysis. In this tutorial, you will be applying a TimeScope analysis to the **Buildings** layer generated in the Build-Out analysis above. For clarity, turn on (display) the **Buildings** layer and **Parcels** layer in the Table of Contents, and turn **off** the **Buildable Area** layer. You can access the TimeScope Wizard using the Scenario 360 toolbar. Click the **Scenario 360** drop-down list and select **Tools > TimeScope Wizard**.

The initial setup screen displays all layers in your analysis, marking the dynamic layers with a dynamic layer icon 📊 and reference (non-dynamic) layers with a reference icon.

If TimeScope has been applied to a layer, its icon changes to a TimeScope icon 🔘. The layer’s start date, end date, build rate, and build order are displayed for informational purposes. To change any of these, edit the layer using the **Edit** button 📊 or double-click on the layer name. The build order indicated refers to features within that layer, not to that layer's order with respect to any other layers.
Setting up TimeScope for a layer

The first time you set up TimeScope in an analysis, a TimeScope Time assumption will be created. You can see its default settings on the opening screen. You may leave these defaults in place. In this tutorial, you will be setting up this assumption for the Buildings layer.

1. Double-click on Buildings in the TimeScope layer list.

2. The Specify Date Range screen is used to designate the start and end dates for the particular layer you are working on. In this case, accept the defaults and click Next.

3. The Build Rate screen is used to specify how quickly additional features are built as TimeScope Time moves forward. Select Exponential growth as the Rate Type then type in the following for Rate Settings and click Next:
   - Use one rate for all scenarios
   - Growth rate = 10% per year
   - Initial features = 15 (meaning 15 new buildings at the start of growth)
   - Existing features = 0

4. The Build Order screen specifies the sequence in which features are built as TimeScope Time moves forward. Select Phase Layer as the Select Order Type. For the Order Settings, select the Parcels layer and the TimeScope Suitability attribute as shown in the image below. This attribute is the one that was created by the Suitability decision tool when you clicked “Create a TimeScope phase attribute.” These settings will cause buildings to appear in the most “suitable” locations first as time moves forward.
5. If desired, TimeScope can automatically keep track of how many features it has built during each time increment. The results can be reported as a set of indicators or in a table. The indicators can then be plotted in sequence as a line chart that shows growth as a function of time. For this step, we’re not going to track feature totals. So, at the **TimeScope Feature Counting** Wizard screen, accept the defaults and click **Next**.

6. At the **Finished** page, accept the defaults and click **Finish** to exit the Wizard and run the **TimeScope** analysis.

Note that like other decision tools, TimeScope does not automatically re-run when you make changes to your analysis. When you are in analysis mode, changing the **TimeScope Time** variable assumption will cause automatic analysis updates in the same way that other assumption changes cause updates. However, if you edit the map, modify formulas, or make other analysis changes, they will not be reflected in TimeScope until you re-run it.

**Experiment with the TimeScope Time assumption**

1. Open the **Assumptions** window by clicking the **Assumptions** button 🏡 on the **Scenario 360** toolbar.
2. Find the TimeScope Time assumption slider bar. If it is not showing, click the **Organize 🔄** button, place a check next to TimeScope Time in the list, and click **OK**.
3. Adjust the slider bar for the assumption **TimeScope Time** to a new position and then click the **Apply Assumption Changes** button 🔄. You will observe the pattern of mapped buildings change as the year changes. The growth of buildings in this example corresponds to the **Suitability** measure you generated earlier: the first buildings will be built in the parcels with the highest Suitability rating and the last built in the parcels with the lowest Suitability rating.
Setting up a common impacts analysis

The Scenario 360 Common Impacts decision tool, or Common Impacts wizard, automatically generates several commonly used impact indicators associated with growth and development over time. Up to twelve standard impacts are generated solely on the basis of a “buildings” layer you specify. Three custom impacts can be generated if you provide additional information or layers to use for reference. All impacts are optional.

For this exercise, you will start by generating the standard set of Common Impacts. The custom impacts will be skipped in this exercise.

1. You can access the Common Impacts Wizard using the Scenario 360 toolbar. Click the Scenario 360 drop-down list and select Tools » Common Impacts Wizard.

2. Accept the default selections on the first page and click Next.

3. On the second page, the Buildings layer should be selected by default, along with the Dwelling Units and Floor Area fields within this layer. These fields are the ones generated by build-out and they are used by Common Impacts by default if they are present. If you had not run a Build-Out analysis prior to running this tool, you could specify an appropriate layer to represent your buildings. If fields equating to dwelling units per building and/or floor area per building were unavailable, you could type in a number for either option.

4. Click the Next button then click the Next button again.

5. The Finished page lists all the assumptions and charts that will be created by the Wizard and asks you some questions about which windows you would like to have open once the Wizard completes its analysis. Uncheck the box labeled “open common impacts assumptions window after window closes” and then click Finish to run the analysis.
Examining the common impacts results

The Common Impacts charts display the results of the analysis you just ran for each scenario.

1. Right click on the chart titled **Annual CO Auto Emissions** and select **View Chart Assumptions** from the pop-up menu.

2. This opens the **Assumptions** window and displays only the assumptions that directly impact **Annual CO Auto Emissions**. These assumptions indicate the base values behind the calculations that were performed.
Click the name next to the slider for any one of these assumptions and the associated **Assumption Information** dialog will open. This dialog contains a description of the source we used for that assumption’s default value.

3. Move the **Passenger Car Fuel Efficiency** slider bar to a new position and then click the **Apply Assumption Changes** button. Note how the values for the various **Annual Auto Emissions** charts changed accordingly. This is a good reminder that these assumption values are intentionally variable. They will change over time and from place to place. Make sure to research your own settings thoroughly to identify corresponding **Common Impacts** assumption values that will make most sense for your individual analyses.

4. Move the **TimeScope Time** slider bar to a new position and then click the **Apply Assumption Changes** button. You should see the values of all the charts for your current scenario change as the set of built buildings is updated.

**Reviewing the Common Impacts report**

The Common Impacts Wizard generates a report called **Common Impacts Report** each time it runs. To access this report, click the **Reports** button on the **Scenario 360** toolbar and then double-click the report of interest to view it in your internet browser. The report is in HTML format. This allows you to click on links to access more information.

Previous common impacts reports are overwritten. To save the report from a particular run, rename it before re-running the Wizard.

**Active content in reports**

Scenario 360 reports may contain **Active Content**. This includes buttons that allow you to expand or collapse individual sections of the report, and information boxes that appear when you hover your mouse over a chart.

1. Click the **Expand** icon next to a heading to see the full contents of that section. Click the **Collapse** icon to show only the heading. You can expand or collapse all sections at once by clicking **Expand All** or **Collapse All** links at the bottom of the report.

2. To view chart, indicator, assumption and/or attribute descriptions, hover your mouse over the chart or component name in the listed tables.
NOTE: Active content uses Javascript code that may be blocked by your browser as a security precaution, so the active content in the report may be disabled when you open a report. You can usually tell when a browser is blocking active content by looking for a message at the top of your browser window. For example, Internet Explorer 6 displays a message like this at the top of the browser window:

To help protect your security, Internet Explorer has restricted this file from showing active content that could access your computer. Click here for options…

To temporarily enable active content on this report only, right-click on the information bar and choose Allow blocked content. You will need to perform this step each time you open the report.

To persistently enable active content for all files stored on your computer (such as these reports), you can change your browser’s settings. See Using the Common Impacts Report in the Scenario 360 Help for detailed instructions.

To view the printer friendly version of the report, click the Printer Friendly button at the top of the report page. This will open a new window with smaller chart images better suited for printing. Note that all the collapsible sections in the report are open by default. If there is a report section you do not wish to print, simply click the Collapse icon for that section and it will be removed from the printed document. Once you are satisfied with the content you wish to print, click the Send to Printer button at the top of the printer friendly report.

Congratulations – you have completed Tutorial 1

This concludes the tutorial for Integrated analysis with decision tools. You have run a suitability analysis, completed a build-out analysis, generated a TimeScope projection for the build-out buildings based upon the suitability analysis, generated some common impacts based upon the buildings layer and studied the combined results.
Tutorial 2 – Explore an existing scenario

This tutorial walks you through exploration of an existing analysis. In this fictional example, a rural mountain valley is being considered for development. Two alternatives, or “scenarios”, are being considered: a traditional large-lot residential housing development, and a village-style compact development with mixed uses of residences and retail establishments. Part of the analysis will compare road costs between the two scenarios. In addition, the analysis will study the suitability of building sites based on several factors: proximity to wetlands that cover part of the valley, proximity to a nesting site for a protected species of bird, and availability of water from water storage tanks that may or may not be at a high enough elevation to provide sufficient water pressure.

The tutorial will also walk you through using Scenario 360 Sketch Tools to paint feature attributes to other features and to clone features.

Once installed using the “Install the tutorial data” directions on page 1, you will find this analysis in the CVFiles\Communityville folder.

In this exercise, you will learn to:
- work with the ArcMap table of contents
- use variable assumptions
- view and use indicators and associated charts
- view and change attributes
- manipulate map features and layers
- compare two scenarios

Suitability and cost analysis of rural residential vs. village development

Tutorial 1 illustrates one of the many kinds of analyses that are possible with Scenario 360 - suitability analysis. In the fictional town of Communityville, some locations are considered appropriate for building (suitable), while others are not. Some factors that might make a location unsuitable include being too close to a nesting site, lying in a wetland area, or having insufficient water pressure. In this tutorial you will experiment with all three.

Objective
Compare and evaluate rural residential development and village-style development in a rural mountain valley.

Issues
- Site suitability
- Road construction costs

Constraints
- Proximity to nesting location
- Proximity to wetlands environmental area
- Elevation of water storage tanks relative to dwelling units

Starting the tutorial

1. Start Scenario 360 by double-clicking on the Scenario 360 icon on your desktop.
2. On the Welcome to Scenario 360 window, click Open Existing Analysis.
3. Browse to the CVFiles/Communityville file, click the file, and click OK.

The tutorial analysis will load in Scenario 360 and display a fictional place called “Communityville”. Communityville is a high mountain meadow site being considered for development.
**Note:** If you are not seeing the data in the map view and red exclamation points are displayed next to your layers in the ArcMap table of contents, you probably installed your software in a non-standard location. When you open a map, ArcMap looks for the data referenced by each layer in the map. If it can't find the data source for a particular layer, that layer won't be drawn. It will display in the table of contents with a red exclamation mark next to its name and the check box next to the layer will be unavailable.

If you know the new location of the data, you can repair the layer by doing the following:

1. Right-click on the layer name, point to **Data**, and click **Set Data Source**.
2. Navigate to the directory containing the correct data source file, click the file, then click **Add**. ArcMap will attempt to find all data (if it is located in the same folder).

**Working with ArcMap**

These tutorials assume that you are familiar with using ArcMap navigation tools.

If you are unfamiliar with the ArcMap toolbar (shown right) and working with the map images, layers, and data sets, refer to the ArcMap help accessed via the ArcMap **Help** menu.

You can size the extent shown in the map view using the **Full Extent** or the **Fixed Zoom Out** buttons. You may also use the **Zoom In** or **Zoom Out** tools, just point, click, and drag your cursor, encircling the desired area of the map to shrink or enlarge it. You can refresh the map view by clicking the **Refresh View** button at the bottom left side of the map view.
Working with toolbars in ArcMap

Toolbars in ArcMap can be docked at the top, bottom, left, or right side of the ArcMap window. Alternatively, toolbars can float on the desktop while functioning as part of the application. When you dock a toolbar, it is moved and resized with the application window. The Scenario 360 toolbar displays as a floating toolbar the first time you launch the Scenario 360 application.

- To move a docked toolbar, click the move handle and drag the toolbar to the new location.
- To move a floating toolbar, click on the title bar and drag the toolbar to the new location. Note: If you drag the toolbar to the edge of the program window, it becomes a docked toolbar. When you move one docked toolbar, this might affect the location and size of other toolbars on the same row.
- To prevent a toolbar from docking, hold down the Ctrl key while dragging it.
- You can close a floating toolbar by clicking the x in the upper right corner of the toolbar. You can open or close toolbars by clicking the View menu, pointing to Toolbars, and then clicking next to the toolbar name you wish to open or close.

You can learn what the toolbar buttons and menu commands do by positioning the mouse pointer over a button or menu command for a second or two. The name of the item will then pop up in a small box. Simultaneously, a brief description will appear in the status bar at the bottom of the application window. To quickly display a longer description of a Scenario 360 toolbar button or menu command, click the What's This? button on the ArcMap toolbar, then click the item you're interested in.

The ArcMap table of contents

Examine the ArcMap table of contents and the symbols representing the various features displayed on the map.

The ArcMap map view

On the map, note the wetlands area and the nesting location. The small green squares represent proposed dwelling units that would constitute a village-style development. The gray lines are roads. All of these features are "layered" over a .tif satellite image of the proposed development. You may toggle these features to change the display on the map by clicking on the check box to the left of the feature in the ArcMap table of contents. Take a few moments to toggle on and off some of the layers in the table of contents and practice using the zoom and extent tools.
Viewing charts

Indicators are impact or performance measures that can reference datasets anywhere in a scenario. They are used to provide an overall measurement and they apply to an entire scenario (as opposed to an attribute, which provides the individual characteristic of a map feature). Indicator values are automatically recalculated as you experiment with alternatives, and these values can be displayed in a chart. Indicators can help people choose alternatives that best match their objectives or desired outcomes. For example, an indicator might be used to evaluate costs, revenues, average household size, "community benefit," or total daily auto trips.

There are three indicators set up for this tutorial:

- Is suitable
- Is not suitable
- Road cost estimation

Charts are dynamically linked to assumptions and indicators. As changes are made in the analysis, chart displays will update automatically to reflect analysis results. Hatched areas on bar charts show the chart’s previous value. Target lines may be included to demonstrate a particular goal or threshold. Charts can contain a single analysis value or many values from the same scenario. They can also display values from different scenarios for comparison.

If the chart view is not open (see image right), click the View Charts button on the Scenario 360 toolbar to display Road Cost and Suitability indicator charts. The View Charts toolbar button works as a toggle button. You can use it to toggle the chart view on and off.
Working with assumptions

An assumption is a value that is used as input to an analysis. They are often changeable, and they always apply to an entire scenario. Assumptions can be a way to express subjective inputs, such as how much weighting to give to a particular community value like open space or economic development.

An assumption can be designated as a numeric value within a valid range (as might be displayed in a slider bar) or as a choice (number, text, or Boolean – yes/no) associated with a defined set of valid values. A numeric assumption can be any number, rate, or standard (number of stories, gallons per household, cost per mile, % discount). “Choice” assumptions may represent a type (dirt, gravel, paved) or time frame (1990, 2000, 2010).

Assumptions can be referenced in any analysis formula. All analysis calculations that depend on an assumption value will be automatically recomputed if you modify that assumption value.

Variable assumptions

A variable assumption is an input to the analysis that might change as part of the analysis, such as the current interest rate, seasonal resource consumption values, residential density, or survey results. A variable assumption may be altered during analysis using a slider bar, choice button, or drop-down list (see image below), and it can vary across scenarios. Slider bars are excellent for setting relative weighting factors.

Fixed assumptions

A fixed assumption is an input to the analysis that will not likely change, such as the municipal water supply. A fixed assumption value cannot be altered and has the same value across all scenarios.

Changing assumptions for the acceptable distance to the nesting area

You will work with variable assumptions to change the minimum acceptable distance between the dwelling units and the nest of a protected species of bird. When the assumption was originally setup, the designers of the analysis set the default location to 300 feet. At that setting, all 72 proposed dwelling units in the Village scenario were found to be in suitable locations, as you can see from the map below (all building locations are colored green) and from the chart (72 suitable locations, 0 unsuitable ones in the Village scenario).

![Map and chart showing suitability of building locations](image)

Working with the variable assumption Bird Nest Setback, you will change the assumption and dynamically update the suitability factor for the building locations in this proposed subdivision. These will be displayed on your map and chart. Start by zooming in or out to a map extent that lets you clearly see the individual buildings in the proposed village. Make sure all layers except “elevation” are visible (place a check in the box next to their name in the ArcMap table of contents).
1. Click the **Assumptions** button on the **360 Analysis** tab to display the graphical assumptions view. Note that the Scenario drop-down list is set to display assumptions for the active scenario (Village).

![](image1.png)

2. You are going to change the acceptable distance from building locations to the nesting site. In this case, you want to explore suitability for building locations located no closer than 600 feet from the nesting site. Click and drag the Bird Nest Setback assumption slider bar to change the assumption value to 600 feet from the nesting site.

   -OR-

   Click the increase or decrease buttons to change assumption value to **600** feet from the nesting site.

3. Click the **Apply Assumption Changes** button to apply your changes. Scenario 360 will update the scenario and dynamically change the suitability (from green to red) of all dwelling units located within 600 map units (which are set in feet) of the nesting site. Buildings in unsuitable locations turn from green to red. Notice the chart values showing number of suitable and unsuitable locations in the Village scenario change as well. Scenario 360 will display the previous value (before the assumption change) with gray diagonal lines. Remember, if you need to refresh the map view, click the **Refresh View** button at the bottom left side of the map view.

4. On the Assumptions display, click the **Tabular** tab. You can also use this dialog box to enter numbers and change assumptions. Notice that the table shows assumptions for both scenarios (Village and Rural) side by side.
Depending on the type of values for the assumptions, you can type directly in the fields or select from a drop-down list.

5. Type 400 in the Bird Nest Setback for the Village scenario and click the Apply Assumption Changes button. Scenario 360 will update the scenario and dynamically change the suitability (back to green from red) of all dwelling units located farther than 400 feet of the nesting site. Notice the chart values change as well.

6. When you are finished, close the Assumptions window and click No when asked whether you want to save assumption changes.

Changing assumptions to prohibit building on wetlands

Now you will work with variable assumptions to change a yes/no assumption about whether building is allowed in the wetlands area. When the assumption was originally setup, the designers of the analysis set the default to No - therefore allowing (not prohibiting) construction in wetlands. This resulted in all 72 proposed dwelling units in the Village scenario were found to be in suitable locations. Working with the variable assumption Prohibit Building in Wetlands?, you will change the assumption and dynamically update the suitability factor for the building locations in this proposed subdivision.

1. Click the Assumptions button on the 360 Analysis tab then click the Graphical tab to display the graphical assumptions view. Note that the Scenario drop-down list is set to display assumptions for the active scenario (Village).

2. Click the Yes radio button next to the Prohibit Building in Wetlands? assumption and click the Apply Assumption Changes button. Scenario 360 will update the scenario and dynamically change the suitability (from green to red) of all dwelling units located on or intersecting the wetland area. Notice also the chart values change as well.

3. When you are finished, close the Assumptions window and click No when asked whether you want to save assumption changes.
Working with the ArcMap map view

When analyzing alternative scenarios, you may want to consider moving features on a map. For example, you may want to move a building further away from a highway or protected area. In this tutorial you have designated a nesting area for a protected species of bird. In this exercise, you will move a building in the Rural scenario away from the nesting area to make it a suitable location for building.

You can move features by specifying delta, x, y coordinates, dragging the feature, or rotating the feature. In this exercise, you will move a building by dragging it to a new location. Dragging is the easiest way to move a feature if you know the general location; for more precise movement, use the delta, x, y coordinates method (instruction available in the ArcMap help).

Moving features in the map view to change suitability

1. Click the Active Scenario drop-down menu on the 360 Analysis tab and select Rural as the active scenario.
2. Click the ArcMap Selection menu (located at the top of the ArcMap interface) then click Set Selectable Layers. This will open a list of available layers that lets you choose which layers you want to select when editing. In this example, you want to select a building by drawing a box around it but you do not want to select the road or any of the features next to it. To avoid selecting multiple features, uncheck all layers except the Proposed Buildings layer and click Close.
3. Click the Start Scenario Editing button on the Scenario 360 toolbar or click Start Edit on the 360 Analysis tab.
4. Select Rural as the scenario you wish to edit and click Edit. Note that your cursor display changes to a pointer and the ArcMap Editor toolbar is displayed (shown below as floating – for more information on floating and docked toolbars, see “Working with toolbars in ArcMap” on page 21).
5. Drag a small box around a building colored red (it is displayed in red because it is in too close to the nesting area). ArcMap will highlight the selected feature and place crosshairs on it.
6. Place your mouse cursor over the crosshairs on the building, click on it, and drag the building North and East to a new location further away from the nesting area. When you stop dragging, you will see the building turn green to indicate it is now in a suitable location. The charts will also change very slightly.
7. Click Stop Scenario Editing on the Scenario 360 toolbar or Stop Edit on the 360 Analysis tab and answer No when asked if you want to save your edits.
Changing water tank location assumptions to determine water pressure suitability

In this analysis there are three possible locations (Site A, Site B, or Site C) for a water tank. The proposed development sits in a high mountain valley, so water pressure can be a problem. In this fictional analysis, it has been determined that a suitable building site must be at least 60 feet below a water tank. To see how this works, you will experiment each of the three possible water tank locations in the Village scenario and see how the building site suitability changes. You may want to zoom out on the map so that you can see all three potential sites for water tanks.

1. Click the **Active Scenario** drop-down menu on the **360 Analysis** tab and select **Village** as the active scenario.
2. Click the **Options** menu on both charts and select **Clear Previous Values** to clear all previous values from each charts.
3. Click the **Assumptions** button on the **360 Analysis** tab to display the graphical assumptions view.
4. Click the drop-down list for the **Water Tank Site** assumption, select **Site A**, and click the **Apply Assumption Changes** button. Scenario 360 will update the scenario and dynamically change the suitability (from green to red) of all dwelling units located higher than an imaginary threshold of 60 feet below the tank at Site A. Try the same experiment with Site B.

5. If desired, you can experiment with moving water tank locations using the techniques you used to move buildings in the exercise “Moving features in the map view to change suitability” on page 26.
6. When you are finished, close the Assumptions window and click **No** when asked whether you want to save assumption changes.
This concludes the suitability portion of the tutorial. You have seen how changing assumptions and moving features on the map can drive changes in indicators illustrated in charts. The suitability of each building is a dynamic attribute that you have seen change based on the analysis you experimented with.

**Running a road cost analysis**

In this exercise you will experiment with changing road construction costs in the Rural scenario. You will change the type of road proposed and then (optionally) change the costs per linear foot in the “Attribute Road Cost” lookup table.

**Evaluating road costs by experimenting with changing the road type**

1. Click the **Active Scenario** drop-down menu on the **360 Analysis** tab and select **Rural** as the active scenario. You may find you want to zoom out a little to see all of the houses.
2. In the ArcMap table of contents, turn off all the layers in the display except **Proposed Buildings**, **Proposed Roads**, and **communityville.tif**.
3. Right-click on **Proposed Roads** in the ArcMap table of contents and click **Zoom to Layer** on the pop-up menu.
4. Expand the **Proposed Roads** layer in the ArcMap table of contents. Note that there are three types of streets in the **Proposed Roads** layer: arterial, collector, and local. Each type has its own construction cost.

5. If the chart view is not open, click the **View Charts** button to display **Road Cost** and **Suitability** charts. Click the **Options** menu on both charts and select **Clear Previous Values** to clear all previous values from the charts.
6. Click the ArcMap **Selection** menu (located at the top of the ArcMap interface) then click **Set Selectable Layers**. This will open a list of available layers that lets you choose which layers you want to select when editing. In this example, you want to select a road but you do not want to select the buildings or any of the features next to it. To avoid selecting multiple features, uncheck all layers except the **Proposed Roads** layer and click **Close**.

7. To view or change feature attributes you must first be in **Edit Mode**. Click the **Start Scenario Editing** button on the Scenario 360 toolbar, select **Rural** as the scenario you wish to edit and click **Edit**. Note that your cursor display changes to a pointer ▶ and the ArcMap Editor toolbar is displayed.

8. Click on the road illustrated below to select it. On selection, the road will turn a different color.

9. Click the **View or Change Feature Attributes** button on the Scenario 360 toolbar to display the **Attributes** for the feature you selected, in this case the **Collector** road type.

10. In the Prompted Attributes pane, double-click on **Road Type**. This will launch a prompt box with a drop-down list of options.
11. Click the Road Type drop-down list, select Arterial from the drop-down list, and click OK. You have just changed that road from a medium-sized “collector” road to a larger “arterial” type, which costs more per unit of length. Scenario 360 will update the Attributes window and the road feature you selected in the map view. The program will also dynamically update the Road Cost chart to reflect the new, higher cost, and display the previous value with gray diagonal lines. You can see exact information by hovering your mouse cursor (pausing for a second or two) over the bar in the chart.

12. Close the attributes window.

13. Notice that an alert⚠️ appears on the chart indicating that a pre-established threshold has been crossed – in this case, a roads budget. Hover your mouse cursor over the chart bar for more information on chart values.

You can set alerts to notify you if a goal, target, threshold, or constraint condition has been reached. An alert may be associated with an assumption, a dynamic attribute, or an indicator. An alert is used to monitor values during analysis and reports if specific conditions occur. Alerts may be displayed as a chart with (colored) target bars, an alert message, or as a feature color on a map. An alert has been set in this analysis to indicate that the roads budget threshold has been crossed.

14. Click once on Alerts⚠️ on the 360 Analysis tab to view more information about the alert you have just triggered. Clear the alert by clicking the Clear All Alerts button then click Close.
15. Click the **Stop Scenario Editing** button on the Scenario 360 toolbar and click **No** when prompted to save your changes.

### Comparing scenarios

This tutorial analysis contains two scenarios. Each scenario represents a different decision-making alternative. Scenario 360 includes a powerful scenario comparison display feature that will allow you to view any combination of maps, images, and/or charts side by side.

1. Make sure that **Proposed Buildings**, **Proposed Roads**, and **communityville.tif** are visible (checked on in the ArcMap table of contents).
2. If the chart view is not open, click the **View Charts** button to display **Road Cost** and **Suitability** charts. Click the **Options** menu on both charts and select **Clear Previous Values** to clear all previous values from the charts.
3. Click the **Compare Scenarios** button on the Scenario 360 toolbar or click **Compare Scenarios** on the **360 Analysis** tab.
4. Use any of the tools described below to modify the map view. When you are finished, close the Scenario Comparison window.

The scenario comparison window includes a toolbar that will allow you to move around the map view, link map extents, and select layout options.

Sometimes just looking at a map isn't enough. You can use the ArcMap **Identify** tool to display all the attributes of a map feature. Click the tool then click on a map feature in the scenario comparison view.

Use the **Pan Map** tool to investigate different areas and features of your map view. Click the tool, move the hand over the map display, and click and drag the hand.

Use the **Zoom In**, **Zoom Out**, and **Zoom to Full Extent** tools to investigate different areas and features of your map view. Click the tool, move the mouse pointer over the map display and click once to zoom around a point in the map view. Alternatively, click and drag a rectangle defining the area you want to zoom in or out on.
Use this **Link Map Extents** tool to synchronize the map extents (zoom and pan settings) shown in the scenario comparison window with one another and with those in the ArcMap map view.

Click the **Select Layout** tool to open an extended toolbar button set of layout options. You can choose from a variety of layout options or customize your window using standard window resize controls (change the width or height of any section of the window by clicking and dragging a border to the desired location). Scenario 360 will "remember" your last saved settings and will display the scenario comparison window as you saved it each time you open the window.

**Task menu** options are available by clicking the Tasks button or by right-clicking on a map, chart, or image in the scenario compare view.

### Scenario comparison features

- The **Edit in ArcMap** tool is available in the **Tasks** menu or right-click pop-up menu when in a 2D map view. This tool allows you to activate a scenario and begin editing it in ArcMap. This will close the Scenario Comparison window and start an ArcMap edit session.
- You can drag and drop charts or scenarios into the scenario comparison view from the **360 Setup** tab Tree view.

The **Compare Scenarios** button on the Scenario 360 toolbar or **Compare Scenarios** on the **360 Analysis** tab options work as toggle buttons. Click either one to turn the Scenario Comparison window on or off.

### Working with CommunityViz sharable 3D scenes

SiteBuilder 3D users can save 3D scenes in a portable format that can be used on other computers. Friends and colleagues can then fly through and explore these 3D scenes on their computer without needing to install any special software. Sharable 3D scenes are transported as a directory containing folders and files. The person who created the sharable 3D scene may share the scene with you by having you download the directory and its contents via the internet or by providing you with a CD or a .zip file. Three 3D scenes have been provided for you to explore on the Resource Disk that shipped with your Scenario 360 software. Copy the **Sharable 3D Scenes** folder to your C:\CVFiles directory. Browse to any or all of the directories listed below and double-click on the **sbviewer.exe** file. This will launch the 3D viewer. Use the instructions provided in the section below to move through the scene using your mouse.

- C:\CVFiles\Sharable 3D Scenes\CommunityRural - Explore the CommunityViz sharable 3D scene of this rural environment with large-lot style development.
- C:\CVFiles\Sharable 3D Scenes\CommunityVillage - Explore the CommunityViz sharable 3D scene of this rural environment with village style development.
- C:\CVFiles\Sharable 3D Scenes\CommunityCity - Explore the CommunityViz sharable 3D scene of this urban environment.

### Moving around in 3D

Use the **Motion** menu to choose how you will move through your 3D scene. You can walk around it or fly over it. There are options in the **Motion** menu that let you set the speed and the eyepoint height from the ground.

It is assumed that you are using a standard three-button mouse (or mouse with a roller ball). The left, middle, and right mouse buttons are referred to as the left, middle, and right mouse.

You can increase or decrease the motion speed by clicking the **Motion** menu, pointing to **Speed**, and clicking one of the options provided. It is recommended you use the **3X** speed to best control your movement.

After you choose a motion model, use the mouse buttons to control the direction of the motion. In general, the speed of the motion increases as the mouse moves away from the center of the 3D view.
Mouse Button | Action
---|---
Left mouse | Moves forward.
Middle mouse | Moves the eyepoint up and down, or pans left and right; position is stationary.
Right mouse | Moves in reverse.
Shift+R | Resets the eyepoint to its starting position.
All three mouse buttons | Resets the eyepoint to the position where the motion model was last changed.

If you get “lost” in the 3D scene or fly beneath the terrain, click all three mouse buttons to reset the eyepoint to its original position.

**Displaying features**

When working with features such as roads, houses, or trees, you can turn their display off and on using the Themes menu. The Themes menu lists all of the features that have been placed in the shared 3D scene. If the feature is displayed, a check appears next to the feature name. To turn off the display of a feature, select it from the list. To display it again, select it again.

**Adding environmental effects**

Sharable 3D scenes offer several environmental effects that you can add to your 3D scene for greater realism. Environment options are located in the Environment menu. You can add clouds, fog, lighting, or set your scene to be viewed as a daytime or nighttime scene.

For more information on CommunityViz sharable 3D scenes, see the “Working with CommunityViz sharable 3D scenes” document on the Resource Disk provided with your Scenario 360 software.

**Scenario 360 Sketch Tools and Land-Use Designer**

In this section, you will sketch a new land-use plan and measure its impacts. You will start by creating a new layer and drawing polygons. Next you will create land-use styles with the Land-Use Designer, then “paint” your new land areas with particular land-use models using Sketch Tools and see the resulting impacts. As a refinement, you will learn how to create or modify land-use models and sketch styles on your own. Finally, you will learn to “clone” an existing feature along with all of its land-use characteristics.

If you have already installed the tutorial data using the “Install the tutorial data” directions, you will find this analysis in the CVFiles\Sunny Vista folder.

**Opening and setting up the data**

1. Go the Scenario 360 toolbar menu, and open the analysis called "Sunny Vista."
   Scenario 360 → Analysis → Open
2. Make Proposal B the Active Scenario.
3. To make it easier to see what you are doing, make the following layers active by clicking on the boxes so that check marks appear:
   - Roads
   - Streams
   - Parcels
   - Ponds
   Turn off the other layers for now.

In this example, imagine that you want to consider adding additional development to Sunny Vista. Start by creating a new polygon layer to represent the proposed new land uses.

1. Go to the 360 Setup tab at the bottom of the Table of Contents.
2. Click the **Data** icon.

3. Click the **Add Data** button. Choose to add a “New Data Layer,” of type “Polygon,” and give it the name “**Proposed Land Uses**.” Click **OK**, and then close the Data list window. Return to the **360 Analysis** tab at the bottom of the Table of Contents. You will see that your new layer is now listed in the Table of Contents, but it doesn’t yet have any features.

4. To add features to Proposed Land Uses, click the **Start Edit** icon on the task panel or Scenario 360 toolbar. Make sure “Proposal B” is selected for editing and choose **Edit**.

5. Find the ArcMap **Editor** toolbar on your screen. (You may need to turn it on via View → Toolbars → Editor.) Click the pencil-shaped ArcMap Sketch Tool, and insure that the Task is set to “Create New Feature” and the Target layer is set to **Proposed Land Uses**.

6. Click on the map to sketch four new **Proposed Land Uses** polygons roughly like those shown in blue here. Their exact shape is not important for this example. Create polygons by clicking once at each vertex. Finish polygons by double-clicking.

When you are finished, choose **Stop Edit** and save your changes.
Starting the Land Use Designer and Scenario Sketch Tools

1. Open the Decision Tools toolbar and the Scenario Sketch toolbar by going to the Scenario 360 toolbar dropdown menu, choosing View, and placing a check next to Decision Tools Toolbar and Sketch Toolbar. Note that Scenario 360 Sketch tools are different from the Sketch Tool on the ArcMap Editor.

2. Start the Land Use Designer by clicking on its button in the Decision Tools toolbar.

3. At the top of the Land Use Designer, select the land use layer Proposed Land Uses.

4. Look at the list of predefined land use models that are available for you to use. For this exercise, deselect all but the following models:
   - LU Commercial
   - LU Mixed Use
   - LU Res Med Density

   The “LU” in front of each name labels it as a predefined “Land Use” model.

5. Click Run.

Based on your settings, the Land Use Designer will create three land use models you can use on your new layer. Each model contains a name and then several attributes appropriate to that land use, such as building densities and resource utilization rates.

Applying Land Use Styles Using Scenario Sketch Tools

1. By default, after closing the Land Use Designer will automatically start an edit session on the Proposed Land Use layer in Proposal B. If it does not, Start the Editor by clicking on Start Edit on the 360 Analysis tab. This will make many of the Sketch functions active.

2. Insure the Proposed Land Uses layer is selectable (preferably the only selectable layer) by using the Selection tab below the ArcMap Table of Contents or by opening the Selection menu on the ArcMap toolbar and choosing Set Selectable Layers.

3. Insure the Target Layer in the ArcMap Editor is still set to Proposed Land Uses.

   Note: You can only paint or clone with a style that exists in the layer you are working on.

4. Insure the Editor is in select mode by clicking on the pointer button.

5. Now click on the "Painter tool" on the Scenario Sketch toolbar. This will automatically open the Style Palette. You can dock or undock the Palette on your screen as desired.

6. Click on the LU Mixed Use style in the Style Palette. You are now ready to paint! Move the paintbrush cursor to the map and either click on or click and drag the mouse over a polygon in the Proposed Land Uses layer that you would like to designate as mixed use. After a few seconds of processing, the polygon will change color, indicating your new style has been applied. Use the same procedure to paint the other polygons in your layer with “LU Commercial” and “LU Res Med Density” styles.
When finished, stop editing and save your edits.

**Viewing Land Use Designer Impacts**

The Land Use Designer created many new dynamic attributes (formula-driven fields) in your Proposed Land Use layer. When you painted the map, particular values were assigned to these fields.

1. You can see the new attributes and their values by opening the layer’s attribute table: right-click on the layer’s name in the Table of Context and choose “Open Attribute Table.” Close the table after looking at it.

The Land Use Designer also set up a number of summary calculations, or “indicators,” based on the feature attribute values.

2. You can see some of these results by clicking on the Charts icon in the 360 Analysis task pane to open up the charts view. You may wish to set the view style to “Active (Proposal B)” at the top of the charts window. Scroll through the charts to find ones whose name contains “LU.”

3. **Experiment** by starting to edit again and then using the paint brush tool to modify the land use style of some of your polygons. You will notice that the chart values update in response to your new proposed plan.

**Customizing Land Use Design Models**

You can modify the pre-defined land-use models you have just used, or you can create entirely new ones. For this exercise you will change some settings in the “LU Med Density Residential” style.

1. Make sure that at least one of your land-use polygons is painted with the LU Med Density Residential style.
2. Note the current values, as shown in the charts, for the indicators “Sum of LU Children” and “Sum of LU Residents.”
3. Reopen the Land Use Designer by clicking on the **Land Use Designer** button on the Decision Tools toolbar and make sure the active land use layer is **Proposed Land Uses**.

4. Highlight the LU Med Density Residential line in the table and click on the Model Properties button. This opens up the Properties window for that model. You may want to take a few minutes to explore the various tabs.

5. On the **Building Info** tab, change the Dwelling Units per Area from 4 to 10. This increases the proposed density and will therefore increase the number of houses and all their impacts.

6. On the **Per Dwelling Unit** tab, change the LU Children per DU value from 0.6 to 0.8. This setting changes the average number of school-aged children in each house for polygons designated as LU Med Density Residential.

7. Click **Finish** to close the model properties wizard, then **Apply Changes** to update your analysis.

8. Compare your new values for “Sum of LU Children” and “Sum of LU Residents” to your previous ones. You will see that they have updated on the basis of the density and per-dwelling unit changes you made.

In this exercise you learned how to use predefined land-use models and how to change existing settings. There are many more capabilities in the Land-Use Designer, including adding additional attributes to models and creating new models from scratch. Refer to the Scenario 360 Help for details.

**More on Working with Scenario Sketch Tools**

When you painted land-use styles onto the map in the exercise above, you used two Scenario Sketch tools: the painter tool and the palette. This part of the tutorial shows you one simple way to create new styles in the palette and shows you how to use the sketch Clone tool. Note that the styles used in this example are simpler than those produced by the Land Use Designer.

1. In the Sunny Vista analysis, display (turn on) the **3D Buildings** layer. Open its attribute table and look at the field called “Floors,” which specifies the number of stories in each building. Notice the mix of 1, 2, and 3-floor buildings.

2. Using the Selection tab at the bottom of the Table of Contents, make the 3D Buildings layer the only selectable layer. On the 360 Analysis tab, click **Start Edit**.

3. On the ArcMap Editor, make sure the Target layer is set to **3D Buildings**. Insure the Editor is in select mode by clicking on the pointer button. Choose one **3D Building** in the residential area at the top of the map by clicking on it. It will be apparent that it has been selected if a turquoise border around the parcel and a black X inside of it are displayed. (If you are not able to select a building, verify steps 2 and 3 above.)

4. Now click on the **Style Palette** on the Scenario Sketch toolbar to open the Palette. You can dock or undock the Palette on your screen as desired. The layer name 3D Buildings should appear at the top of the palette automatically.

5. Click the **Create New Style** button on the Palette to create a new style based on the feature you have selected. When you are prompted for a name for this new style, enter the name ”My Custom Building.” A new Style should appear in the list of Styles in the Palette.

6. Double-click on the name My Custom Building in the Palette to open it in the Style Manager. Notice the attributes available in the layer.

7. Select the Height, Dwelling Units, and Floors attributes for inclusion in the style, and set their values to 44, 3, and 4, respectively, as shown in the figure.
Painting features with other attributes

1. Make sure you are still editing and your building is still selected. On the Palette, and click the **Apply** button to apply the attribute values of My Custom Building to that building. **Stop Editing** and **Save** your edits.

2. To make your future work clear, symbolize the 3D Buildings layer based on Height. To do so, double-click the layer name in the Table of Contents, go to the Symbology tab, and choose to Show Categories... Unique Values using the Field “Height.” Click **Add All Values**.

3. Start editing again. Click on the "Painter tool" on the Scenario Sketch Tools toolbar, and click on the My Custom Building style in the Palette.

4. Move the paintbrush cursor to the map and either click once or click and drag the mouse over several 3D Buildings to apply your style. Notice how their color changes because their Height attribute value has change to 44. You may use the ArcMap Identify tool to verify that your other specified attributes have also been applied.

5. Now move to a different area of the map, hold down the control button and click to create the boundary of a polygon surrounding 3D Buildings that you would like to paint with the My Custom Building style. Double-click to close the polygon.

6. Click on the Stop Edit button, and when asked "Do you want to save your edits?" choose Yes.

Cloning features

7. Click on the ArcMap **Start Edit** symbol to resume editing.

8. Click the **Clone Tool** on the Scenario Sketch Tools toolbar. This will automatically open the Palette. On the Palette, click the **Views** dropdown and choose “ Thumbnails”. You will see that your style has an associated “prototype shape” based on the single feature you had selected when you created the style. Click it to set the clone tool.

8. Click on the "Save" icon to save this style which you have just modified. Close the Style Manager.
9. Click several times on the map to place copies, or “clones” of your building on empty land. When finished, Stop Editing.
10. Right-click on the 3D Buildings layer in the Table of Contents and select “Open Attribute Table.” Look at the last few features listed in this layer’s attribute table to see the characteristics of the clones that you created. Does their height match the expected value?

For more information on using Scenario Sketch Tools, go to Scenario 360 Help.

**Congratulations – you have completed Tutorial 2**
This tutorial has taken you through a sample analysis using Scenario 360. Tutorial 3 will walk you through the process of setting up a new analysis which you will then be able to explore.
Tutorial 3 – Setting up and running an analysis

This tutorial is based on a fictional urban environment called Community City. In this tutorial, you will set up an analysis to look at the cost implications of adding various structures to a proposed development area. This development envisions a new mixed-use development that includes retail, residential, and office buildings. The analysis will include studying the jobs to population balance for various combinations of retail, residential, and office buildings. You will also explore the construction costs inherent in adding more space.

This tutorial will take you through the basic steps for setting up a new analysis in Scenario 360. You will learn to:

• create a new analysis
• define a projected coordinate system
• create a new base scenario
• add data layers
• create, modify, and chart assumptions
• setup and work with dynamic attributes and formulas
• create and chart indicators
• define and display alerts
• add features

Objective
Evaluate commercial development options for a mixed-use development.

Issues
• Population densities
• New jobs
• Construction costs

Starting a new analysis

1. If you haven’t already, start Scenario 360 by double-clicking on the Scenario 360 icon on your desktop. If Scenario 360 is open, click the Start a Scenario 360 Analysis button on the Scenario 360 toolbar.
2. On the Welcome to Scenario 360 window, click Create New Analysis.
3. Select Create new empty analysis and click Next.
4. In the Analysis Name field, type Community City.
5. In the Description field, type My practice analysis tutorial 2 and click Next.
6. Accept Base Scenario as the base scenario name.
7. In the Description field for the Base Scenario, type Original proposal, click Next, then click Finish. Scenario 360 will update your files and create your new analysis folders.

Prepare your data
Although prepared data is provided for these tutorials, you will want to get your own data into a common projected coordinate system when you are ready to do your own analysis.

Common projected coordinate systems
The features on a map reference the actual locations of the objects they represent in the real world. The positions of objects on the spherical surface of the Earth are measured in geographic coordinates as latitude and longitude. Degrees of latitude and longitude vary in actual distance with location on the surface of the Earth and so data is often transformed to two-dimensional projected coordinates. A map projection describes the way in which the information on the Earth surface is projected onto that flat surface using shapes such as a cylinder, cone, or tangent adjacent to the sphere.
You will need to use a projected coordinate system such as UTM or State Plane to do analyses in Scenario 360.

**How to define a coverage's coordinate system**

1. Right-click on your coverage's name in the ArcMap table of contents and click on **Properties**.
2. Go to the **Coordinate System** tab and determine whether the projected coordinate system is defined for your coverage.
3. If it is not, go to the box entitled "Select a coordinate system:" and expand the Predefined folder and then the **Projected Coordinate Systems** folder.
4. Choose from the projections listed in the Continental folder, the State Plane folder, the UTM folder, or another folder depending on your map location. Different map projections distort or preserve **shape**, **distance**, **area**, and **direction** and are typically applied to certain regions of the Earth or certain sizes or shapes of land.

For more information on the pros and cons of the various projected coordinate systems, go to the ArcGIS web page entitled "An overview of map projections" either by searching the internet or the ESRI help page at:


**Adding data**

In ArcGIS, geographic information is displayed on a map as **layers**. Each layer represents a particular type of feature such as streams, lakes, or highways. A layer doesn't store the actual geographic data; instead, it references the data contained in coverages, shapefiles, geodatabases, CAD files, images, grids, and so on. Referencing data in this way allows the layers on a map to automatically reflect the most up-to-date information in your GIS database.

Scenario 360 allows you to select additional datasets (e.g. photos, lookup tables, census data, models, and other non-geographic data) from which to create layers, and allows you to examine properties of the attributes contained in each dataset.

**Adding existing data layers**

There are several sources from which to retrieve data for your analysis. For this tutorial, you will use some CommunityViz provided data layers, and also create some of your own data.

1. Click the 360 Setup tab Work Flow view.
2. Click once on Data to open the data list.
3. Click the Add Data button.
4. Select **Existing Data Layer** and click **Continue**.
5. Browse to **CVFiles/Tutorial 3**
6. While holding down the Shift key, click to select both available data layers, then click Add. Scenario 360 will add the data to your analysis. You will see an aerial photo and parcels in your map view. These are representative of data you might get from other sources in a real analysis.

Adding a new empty data layer
Next you will create your own data layer by adding a new, empty dynamic layer for proposed new buildings. Later in this tutorial, you will sketch new buildings into this layer.

1. Click the Add Data button on the data list (if you closed the data list, you can reopen it from the 360 Setup tab Work Flow view, Data icon).
2. Select New Data Layer and click Continue.
3. In the Name field, type Proposed_Buildings. (Note that spaces ( ) [ ] { } : , " \ , tabs, or returns are not allowed in data layer names.)
4. In the Description field, type Proposal for new buildings.
5. Click the Layer Type drop-down list and select Polygon.
6. Click OK. Scenario 360 will add your new layer to the ArcMap table of contents. Note that the check box in the ArcMap table of contents has a bright outline, indicating that this is a dynamic layer. It is also represented with a different icon in the data list.
7. Close the data list. You have completed the steps of adding data layers to your analysis.

Working with 360 Setup tab
The 360 Setup tab is used to access all of the tools and information you need when setting up an analysis.

When thinking about an analysis, you can think of it as something with inputs, calculations, and outputs - as displayed in the Work Flow view (shown in the image right). You can follow the steps suggested by the flow chart to set up your analysis.

Input
- Data are inputs that consist of map layers and tables.
- Assumptions are inputs that are user-defined inputs used in an analysis. They are often changeable.

Calculations
- An analysis can contain one or more alternative scenarios. Scenarios are alternative viewpoints of an analysis. Each scenario has distinct input settings and outputs, but identical calculation rules.
- Attributes are properties or characteristics of map features. A dynamic attribute is an attribute that is automatically or manually updated as changes are made in the analysis using the unique capabilities of Scenario 360.
- Indicators are impact or performance measures. They are calculated output values that can reference data sets anywhere in the scenario. They are used to provide an overall measurement for a scenario (as opposed to an attribute, which provides the individual characteristic of a map feature).

Output
- Alerts are thresholds, defined by you, that are associated with particular assumptions, dynamic attributes, or indicators. Alerts let you know if a scenario value is outside of a specification.
- Charts are a graphical way of looking at indicators or assumptions.
- Reports summarize the inputs, calculations, and outputs of one or more scenarios.

You can use the Work Flow, Tree, or Category view when setting up your analysis.
Creating a new category

Categories are a convenient way to organize a complex analysis by creating groups of information that can be applied across all indicators, assumptions, attributes, and charts. Use categories to filter, sort, and keep track of groups of information.

You can create and name your own categories. In this tutorial, you will create and utilize a **Construction Cost** category that includes all of the indicators, assumptions, attributes, and charts that apply to your work on construction costs in the analysis.

1. Click Category on the **360 Setup** tab.
2. Click the New Category toolbar button \[ \]
3. Type Construction Cost as the new category name and click OK.

Reordering categories

Category order is reflected in category lists throughout the analysis as well as in reports. In this analysis, you will use the General category for most of your analysis components. You can put that category at the top of the list for easy access when creating components.

1. Click once to select the General category.
2. Click the Move Category Up button \[ \]

Creating assumptions

Assumptions in a scenario can be defined as fixed or variable. A variable assumption is an input to the analysis that might change as part of the analysis, such as the current interest rate, seasonal resource consumption values, or residential density. A variable assumption may be altered (using a slider bar or other method) during analysis and can vary across scenarios. For more information on assumptions, see “Working with assumptions” on page 23.

In this exercise, you will set up assumptions about how much of the floor space in the proposed new buildings will be used for each purpose. These will be variable assumptions that you will be able to change later. You will create three variable assumptions: Residential Ratio, Retail Ratio, and Office Ratio.

Creating the Residential Ratio variable assumption

The first variable assumption is called “Residential Ratio.” It represents the percentage of floor space that will be dedicated to residential use.

1. Click once on **Assumptions** on the 360 Setup tab **Work Flow** view.
2. Click the **New Assumption** toolbar button \[ \]
3. In the **Name** field, type Residential Ratio. (Note that ( ) [ ] { } : , " ', tab, return, leading or trailing spaces are not allowed in assumption names.)
4. In the **Description** field, type Percentage of floor space dedicated to residential use.
5. Accept **General** as the **Category**.
6. Accept **Number** as the **Format**.
7. Accept the selection **Yes**, this is a variable assumption.
8. Click the **Valid Values** tab.
9. Type 70 in the **Default Value** field, indicating that unless the assumption is changed, 70% of the new floor space will be residential. This will be the default display value.
10. Type % in the Units field.
11. Accept the default of 1 for the Increment on Slider. This number represents the number of units traveled each time you click on the slider increase or decrease buttons when experimenting with the assumption values.
12. Accept 0 as the Minimum value.
13. In the Decimal Places field, type 0.
14. Accept 100 as the Maximum and click OK.

Creating the Retail Ratio variable assumption
1. If you closed the assumptions list, click once on Assumptions on the 360 Setup tab Work Flow view.
2. Click once on the Residential Ratio assumption in the assumption list to select it then click the Duplicate button . This will create a new assumption with the same properties and values as the Residential Ratio assumption. Any of the new assumption values or properties can be modified as you wish.
3. In the Name field, type Retail Ratio.
4. In the Description field, type Percentage of floor space dedicated to retail use.
5. Click the Valid Values tab.
6. Type 10 in the Default Value field, indicating that unless the assumption is changed, 10% of the new floor space will be retail. This will be the default display value.
7. Accept all other fields and click OK.

Creating the Office Ratio variable assumption
1. If you closed the assumptions list, click once on Assumptions on the 360 Setup tab Work Flow view.
2. Click once on the Retail Ratio assumption and click the Duplicate button .
3. In the Name field, type Office Ratio.
4. In the Description field, type Percentage of floor space dedicated to office use.
5. Click the Valid Values tab.
6. Type 20 in the Default Value field, indicating that unless the assumption is changed, 20% of the new floor space will be office space. This will be the default display value.
7. Accept all other fields and click OK.
8. Close the assumptions list.

Editing assumptions (optional)
You have finished setting up the variable assumptions for the analysis. If you want to make changes however, you can.
1. Open the assumptions list.
2. Double click on any assumption.
3. Change properties, valid values, and alerts. In this exercise, accept the properties defined in the previous exercises and close the assumptions list.

Creating dynamic attributes and associated formulas
A dynamic attribute is an attribute that is updated as changes are made in the analysis using the unique capabilities of Scenario 360. A formula is associated with each dynamic attribute. The formula specifies how the attribute is calculated.

Dynamic attribute formulas
Formulas are expressions that specify how the elements of an analysis depend upon one another. They are statements in an equation of facts, rules, principles, or other logical relationships. The ability of Scenario 360 to
calculate values dynamically, using formulas, is a powerful and unique tool; it enables you to make changes in your analysis and see the results immediately.

**Types of formulas**
- **Attribute formulas** specify the value of dynamic attributes, which are changeable characteristics associated with particular features on the map. Example attributes include name of a road, number of children living in a house, or taxes for a particular lot. Attribute values are usually found by looking at symbols on a map or by clicking on a particular feature to open its attribute table.
- **Indicator formulas** specify the value of indicators, which quantify information that pertains to a scenario as a whole. Example indicators include cost of roads, number of school-age children in a neighborhood, or town tax revenues.

For example, an attribute formula might be used to calculate the cost of each proposed road feature on a map by multiplying the length of the road times the cost per square foot. An indicator formula might be used to sum the total costs for all roads in a scenario by adding the above attribute values.

In the following exercises, you will be creating new dynamic attributes and attribute formulas using a variety of options for creating formulas. You will create indicators and indicator formulas later in this tutorial.

**Using the Formula Wizard to create a prompted dynamic attribute**
Recall that you created a new, empty layer called **Proposed Buildings**. During analysis, a user will sketch new buildings on the map. You want the software to “ask” the user how many stories tall the building is by displaying a small dialog box each time a new building is created. This is known as a “prompted” attribute.

1. Click once on **Dynamic Attributes** on the **360 Setup** tab **Work Flow** view.
2. Click the **New Attribute** button .
3. In the **Name** field, type **Stories**.
4. In the **Description** field, type **Prompts the user to enter the number of stories for new buildings**.
5. Accept **General** as the **Category**.
6. Click the **Layer** drop-down list and select **Proposed_Buildings**.
7. Accept **Number** as the **Attribute Type** field.
8. Leave the **Units** field blank.
9. In the **Decimal Places** field, type **0**.
10. Click the **Formula** tab.
11. Click the **Formula Wizard** button. The Formula Wizard assists you in constructing the most common types of analysis formulas.
12. Attributes can be designated as numeric, yes/no, or text. Each of these attribute types include different options when constructing formulas in the Formula Wizard. You are going to be creating a formula function that prompts a user when creating buildings to enter a number (the number of stories in building). Select the **Prompt for a number** option and click **Next**.
13. Select the **Prompt for a specific numeric value** option and click **Next**.
14. In the **Question or statement for prompt field**, type **Please specify number of stories.**
15. Click to place a check mark in the **Provide Default Value** box and type **1** in the field provided.
16. Notice that the program displays your entries in the **Preview of prompt** window as well as a preview of the formula in progress. Click **Next**.
17. Click **Finish** but do not close the attribute creation window.

### Creating an alert

You can create an alert to notify users when they create a building that is over 10 stories tall.

1. Click the **Alerts** tab in the attribute creation window.
2. Click **New**.
3. In the **Alert Name** field, type **Too Tall**.
4. In the **Description** field, type **Building is more than 10 stories tall**.
5. In the **If Stories is** operator drop-down list, select **>** (greater than) in the first box and type **10** in the next box.
6. In the **Display the following messaging in a popup window** field, type **This building is more than 10 stories tall**.
7. Accept the default **Alert Color** and click **OK**.
8. Click **OK** to close the attribute creation window.

### Testing your new formula and alert

You can sketch a new building in your map view and watch your new formula at work.

1. Using the ArcMap zoom tools, zoom in on the parcels area of the map view.
2. Make sure the symbology in the table of contents for the **Proposed_Buildings** layer is a noticeable color. If it isn’t, you can double click on the symbol, click the **Symbology** tab, and select a new color.
3. Start an editing session by clicking the **Start Scenario Editing** button on the Scenario 360 toolbar.
4. Click on the **Sketch Tool** on the ArcMap Edit toolbar. Make sure the **Task** drop-down list has **Create New Feature** selected and that the **Target** drop-down list has **Proposed Buildings** selected.
5. Draw a large polygon in one of the parcels to represent the footprint of a potential new building (see image below). Click to create each point, when you have finished creating your points, double-click on the last point to complete the polygon.

6. When prompted, type **11** in the Stories field and click **OK**.
7. Because you exceeded the threshold you set (buildings cannot be more than 10 stories tall), the new building is displayed with a red border around it.
8. Click the **Stop Scenario Editing** button on the Scenario 360 toolbar and click **Yes** to save your edits.
9. Click the **List Alerts** button on the Scenario 360 toolbar to view the alert notification then close the list alerts window.

**Using the Formula Editor to create a dynamic attribute**

You can create a dynamic attribute in the proposed buildings layer that will calculate the area of a building in square feet.

1. From the attributes list click the **New Attribute** button (if you closed the attributes list, you can reopen it by clicking **Dynamic Attributes** on the **360 Setup** tab **Work Flow** view).
2. In the **Name** field, type **Building Area**.
3. In the **Description** field, type **Total area of building in square feet, including all floors**.
4. Accept **General** as the **Category**.
5. Click the **Layer** drop-down list and select **Proposed_Buildings**.
6. Accept **Number** as the **Attribute Type** field.
7. Leave the **Units** field blank (this will be calculated for you).
8. In the **Decimal Places** field, type **0**.
9. Click the **Formula** tab.
10. Click the **Edit Formula** button. The **Formula Editor** will be used to create this formula. Conceptually, the formula is simple: multiply the area of the building’s footprint by the number of stories.
11. Double-click **Area** in the function list. You will see the text appear in the formula box. For detailed information on the Area function, click the More help on this function link.

12. Using the Formula Editor keypad, click the multiplication sign *.

13. Click the Insert Analysis Component button [ ] on the Formula Editor toolbar.

14. Double-click on **Attribute** on the pop-up menu, then double-click on **Stories** on the pop-up menu (you may have to scroll down).

**Using the Formula Wizard to create a dynamic attribute**

Now that you have set up the building area and the percentage of area dedicated to residential, retail, and office use, three simple formulas will give you the absolute area dedicated to each use.

**Calculating office area**

1. If you closed the attributes list, you can reopen it by clicking **Dynamic Attributes** on the 360 Setup tab **Work Flow** view.

2. From the attributes list click the **New Attribute** button [ ].

3. Create a new attribute named **Office Area** in the **Proposed_Buildings** layer. Use the **Number** type, **General** category, and set the decimal places to 0.
4. In the **Description** field, type **Building area dedicated to office use**.

5. Click the **Formula** tab and click **Formula Wizard**.

6. Click to select the **Calculate a value** option and click **Next**.

7. Using the drop-down lists provided, select the options shown in the image below. You will have to click the **Add Line** button to create a third line.

![Formula for Attribute Proposed_Buildings:Office Area](image)

8. Your formula should read:
   
   [ Attribute:Building Area ] * [ Assumption:Office Ratio ] / 100

9. Click **Next** then click **Finish**.

10. Click **OK** to close the attribute creation window.

This completes the creation of the Office Area formula. You can make a similar formula for retail very quickly using the **Copy formula** button in the Formula Editor.

**Duplicating a dynamic attribute to calculate retail area**

1. If you closed the attributes list, click once on **Dynamic Attributes** on the **360 Setup** tab **Work Flow** view.

2. Click once on the **Office Area** assumption and click the **Duplicate** button 🔄.

3. Rename the attribute **Retail Area**. It is in the **Proposed_Buildings** layer. Use the **Number** type, **General** category, and set the decimal places to 0.

4. In the **Description** field, type **Building area dedicated to retail use**.

5. Click the **Formula** tab and click **Edit Formula**.

6. Replace the word **Office** with the word **Retail** in the formula. The formula should read:
   
   [ Attribute:Building Area ] * [ Assumption:Retail Ratio ] / 100

7. Click **Check Formula**, then click **OK**. Click **OK** again to close the attribute creation window.

**Copying a formula to calculate residential area**

1. From the attributes list click the **New Attribute** button 🖋.

2. Create a new attribute named **Residential Area** in the **Proposed_Buildings** layer. Use the **Number** type, **General** category, and set the decimal places to 0.

3. In the **Description** field, type **Building area dedicated to residential use**.
1. Click the **Formula** tab and click **Edit Formula**.
2. Click the **Copy formula from another attribute** button , click once to select the very similar attribute **Office Area**, and click **OK**.
3. Replace the word **Office** with the word **Residential** in the formula. The formula should read:
   \[
   \text{[ Attribute:Building Area ]} \times \text{[ Assumption:Residential Ratio ]} / 100
   \]
4. Click **Check Formula**, then click **OK**. Click **OK** again to close the attribute creation window.
5. Close the attributes list.

### Creating a new chart

Values for indicators and assumptions are automatically calculated as you experiment with alternatives, and the results can be displayed graphically in a chart. Charts are dynamically linked to assumptions and indicators. As changes are made in the analysis, chart displays will update automatically to reflect analysis results.

In this exercise, you will create a pie chart that tracks the percentage of each building type.

1. Click once on **Charts** on the **360 Setup** tab **Work Flow** view.
2. Click the **New Chart** toolbar button .
3. In the **Name** field, type **Floor Space Ratios**.
4. This will become the title of your chart. Leave the **Subtitle** field blank.
5. Click the **Type** drop-down list and select **Pie**.
6. In the **Decimal** places field, type **0**.
7. Leave the **Display Values** and **Display Legend** options checked and click to place a checkmark next to **3D**.
8. Click the **Data** tab and click the **Add Assumption** button.
9. Click once on **Residential Ratio** to select it, then click **OK**.
10. Click the **Add Assumption** button, click once on **Retail Ratio** to select it, then click **OK**.
11. Click the **Add Assumption** button, click once on **Office Ratio** to select it, then click **OK**.
12. Click **OK** to close the create chart window. Your new chart will be added to the list.
13. Close the charts list.

14. Save your analysis by clicking the **Save** button on the ArcMap toolbar.
Tutorial 3b – Advanced setup and analysis

This part of the tutorial includes the advanced topic of lookup tables, which can sometimes be used in complex analyses. Once you have created your lookup table, you can create dynamic attributes that reference information in it. You must first complete Tutorial 2a before beginning this tutorial.

Creating a lookup table
You will start by creating a lookup table. Strictly speaking, you don’t need a lookup table for this formula. Lookup tables are best for large amounts of data that don’t change very often (like tax rates). We are using a small lookup table here to expose you to this potentially useful technique. There are several ways to create lookup tables from scratch; we are presenting one option here.

1. Make sure that you are not in an active editing session (click the Stop Scenario Editing button on the Scenario 360 toolbar if available).
2. Click once on Data on the 360 Setup tab Work Flow view.
3. Click the Add Data button.
4. Select New Data Layer and click Continue.
5. In the Name field, type Lookup, then type a description of your choice in the Description field.
6. Click the Layer Type drop-down and select Table.
7. Click OK then close the data list.
8. Click the 360 Setup tab then click the Tree view.
9. Click the + next to the Data folder to expand the folder.
10. Right-click on Lookup and click Open Attribute Table from the pop-up menu to display the attributes of this table.
11. Click the Options button (at the bottom of the table) and click Add Field on the pop-up menu.
12. In the Name field, type Land_Use (spaces are not allowed).
13. Click the Type drop-down and select Text. This will be the column in your table that specifies residential, office, or retail.
14. Click OK.
15. Using the Short Integer type, create additional fields for Area_per_Dwelling_Unit, Area_per_Employee, and Cost_per_Sq_Foot (use the directions in #12).
16. Start an editing session by clicking the Start Scenario Editing button on the Scenario 360 toolbar.
17. Enter three rows of data in your table, as displayed in the image below. Note that you do not need to enter any data in the OBJECTID* field or the SCENARIO field. Those will populate automatically. You may need to resize the window to see the table properly.

<table>
<thead>
<tr>
<th>OBJECTID</th>
<th>SCENARIO</th>
<th>Land_Use</th>
<th>Area_per_Dwelling_Unit</th>
<th>Area_per_Employee</th>
<th>Cost_per_Sq_Ft</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Base Scenario</td>
<td>Residential</td>
<td>1000</td>
<td>125</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Base Scenario</td>
<td>Office</td>
<td>0</td>
<td>175</td>
<td>225</td>
</tr>
<tr>
<td>3</td>
<td>Base Scenario</td>
<td>Retail</td>
<td>0</td>
<td>200</td>
<td>500</td>
</tr>
</tbody>
</table>
18. Click the Stop Scenario Editing button on the Scenario 360 toolbar. When asked if you want to save your edits, click Yes. Close the lookup table.

Editing attributes
1. Right-click on the Attributes folder (360 Setup tab Tree view) and click Attribute List on the pop-up menu.
2. Click once on the Area_per_Employee attribute and click the Properties toolbar button.
3. Ensure that the Attribute Type drop-down list reads Number.
4. Change the Decimal Places field to 0.
5. Click OK and close the attributes list.
Creating a variable assumption
In this exercise, you will setup an assumption for persons per dwelling unit and use this assumption to study jobs to population balance for various combinations of retail, residential, and office buildings.

1. Click once on Assumptions on the 360 Setup tab Work Flow view then click the New Assumption toolbar.
2. In the Name field, type Persons per Dwelling Unit.
3. In the Description field, type Average number of people living in each dwelling unit.
4. Click the Valid Values tab.
5. Type 1.6 in the Default Value field, indicating that unless the assumption is changed, the average number of people in each dwelling unit is 1.6. This will be the default display value.
6. Leave the Units field blank and accept 0 as the Minimum value.
7. Type .1 for the Increment on Slider.
8. In the Decimal Places field, type 1.
9. Type 4 as the Maximum and click OK.
10. Close the assumptions list.

Creating dynamic attributes using information from a lookup table
You are now ready to create new dynamic attributes. You will use the Formula Wizard and Formula Editor to create your formulas. Many of the new attributes will rely on your lookup table for data.

Creating the Office and Retail Employees dynamic attributes
The formula for these attributes will rely on your lookup table for data and will calculate the number of employees expected in the new buildings based on the square feet of office space. The formula starts by calculating the square feet of office or retail space and then divides by the number of square feet associated with each employee. It gets the number from the lookup table which shows how many square feet are needed for employees of offices or retail stores.

1. Open the attributes list and create a new attribute named Office Employees in the Proposed_Buildings layer. Use the Number type, General category, and set the decimal places to 0.
2. In the Description field, type Number of employees expected based on availability of office space.
3. Click the Formula tab then click the Edit Formula button.
4. Click the Insert Analysis Component () button on the Formula Editor toolbar.
5. Double-click on Attribute on the pop-up menu, then double-click on Office Area on the pop-up menu.
6. Using the Formula Editor keypad, click the division sign /.
7. Double-click Get in the function list. You will see the text appear in the formula box.
8. Click on attribute in the formula preview box and click Select Attribute on the pop-up menu.
9. Scroll down the list, click once on Area_per_Employee, then click OK.
10. Click on where in the formula preview box and click Edit Where Clause on the pop-up menu.
11. Click the Attribute drop-down and select Land_Use, accept the = (equal) operand.
12. Click the Value drop-down list, select Office, then click OK. Your formula should read: 
   \[ \text{Attribute:Office Area} / \text{Get \{ Attribute:Lookup:Area_per_Employee }, \text{Where ( Attribute:Lookup:Land_Use } = \text{"Office" } ) \]
13. Click the Check Formula button. Click OK after you have finished.
14. Click OK to close the attribute creation window.
15. Create a new Retail Employees attribute by duplicating the Office Employees attribute (use the Duplicate button on the attribute setup list). Make sure your decimal points are correct and that you replace "Office" with "Retail" in the name and description fields as well as in the formula. The formula should read:
   \[ \text{Attribute:Retail Area} / \text{Get \{ Attribute:Lookup:Area_per_Employee }, \text{Where ( Attribute:Lookup:Land_Use } = \text{"Retail" } ) \]
16. Click the **Check Formula** button. Click **OK** after you have finished.
17. Click **OK** to close the attribute creation window.

**Creating the Dwelling Units dynamic attribute**

You will use this attribute to calculate population. As you change the persons per dwelling unit assumption, this attribute will update automatically.

1. Create a new attribute named **Dwelling Units** in the **Proposed_Buildings** layer. Use the **Number** type, **General** category, and set the decimal places to **0**.
2. In the **Description** field, type **Area per residential dwelling unit**.
3. Click the **Formula** tab then click the **Edit Formula** button.
4. Using the skills you have practiced earlier, see if you can create this formula:
   \[
   \text{[Attribute:Residential Area]} / \text{Get([Attribute:Lookup:Area_per_Dwelling_Unit], Where([Attribute:Lookup:Land_Use] = "Residential"))}
   \]

You can use the hints in the picture below to create your formula. Remember, you must click **Check Formula** before clicking **OK**.
**Creating the Population dynamic attribute**

You need to calculate population in order to experiment with jobs to population balance for different combinations of retail, residential, and office buildings. You will begin creating this formula using the Formula Wizard and then complete it using the Formula Editor.

1. Create a new attribute named **Population** in the **Proposed_Buildings** layer. Use the **Number** type, **General** category, and set the decimal places to **0**.
2. In the **Description** field, type **Population based on persons per dwelling unit, number of dwelling units, and office and retail employees**.
3. Click the **Formula** tab then click the **Formula Wizard** button.
4. Click **Calculate a Value** then click **Next**.
5. Using the drop-down lists, create the formula shown in the picture below.

6. Click **Next**
7. Click the **Open Formula Editor** button and click **Yes** when asked if you want to continue.
8. Type parentheses in the correct places so your formula reads:
   
   $$
   ( \text{[ Attribute:Dwelling Units ]} \times \text{[ Assumption:Persons Per Dwelling Unit ]} ) + \text{[ Attribute:Office Employees ]} + \text{[ Attribute:Retail Employees ]}
   $$

9. Click the **Check Formula** button. Click **OK** after you have finished.
10. Click **OK** to close the attribute creation window but do not close the attributes list.
Creating the Construction Cost dynamic attribute

Later, you will run a cost analysis. You will consider adding another building to the development project. However, your budget is limited. How much space can you add? You will use this attribute to answer this question and see the results of the additional space immediately.

1. Create a new attribute named Construction Cost in the Proposed_Buildings layer. Use the Number type, Construction Cost category, and set the decimal places to 0.
2. In the Description field, type Cost per square foot of office, residential, and retail space.
3. Click the Formula tab then click the Edit Formula button.
4. Using the skills you practiced earlier, see if you can create this formula (don’t forget to insert the parentheses!):
   \[
   \left( \left[ \text{Attribute:Office Area} \right] \times \text{Get} \left( \left[ \text{Attribute:Lookup:Cost_per_Sq_Ft} \right], \left[ \text{Attribute:Lookup:Land_Use} \right] = \text{"Office"} \right) \right) + \\
   \left( \left[ \text{Attribute:Residential Area} \right] \times \text{Get} \left( \left[ \text{Attribute:Lookup:Cost_per_Sq_Ft} \right], \left[ \text{Attribute:Lookup:Land_Use} \right] = \text{"Residential"} \right) \right) + \\
   \left( \left[ \text{Attribute:Retail Area} \right] \times \text{Get} \left( \left[ \text{Attribute:Lookup:Cost_per_Sq_Ft} \right], \left[ \text{Attribute:Lookup:Land_Use} \right] = \text{"Retail"} \right) \right)
   \]
5. You can use the hints in the picture on the previous page to create your formula. Remember, you must click Check Formula before clicking OK.
6. Close the attributes list.

Creating indicators and alerts

Indicators are impact or performance measures that can reference datasets anywhere in a scenario. They are used to provide an overall measurement and they apply to an entire scenario (as opposed to an attribute, which provides the individual characteristic of a map feature). Like dynamic attributes, indicator values are automatically recalculated as you experiment with alternatives, and these values can be displayed in a chart. In this fictional analysis, you will use indicators to total population, employees, construction costs, and ratio of square footage and you will display your results in easy to read charts.

Creating the Population indicator

1. Click once on Indicators on the 360 Setup tab Work Flow view.
2. Create a new indicator named Population. Use the Number type, General category, and set the decimal places to 0.
3. In the Description field, type Total population.
4. Click to place a checkmark next to Display this indicator in a new chart.
5. Click the Formula tab then click the Formula Wizard button.
6. Select Add the values of an attribute and click Next.
7. Click to select Proposed_Buildings from the Select Layer drop-down list.
8. Click to select Population from the Select attribute to sum drop-down list.
9. Ensure the sum all features in Proposed_Buildings option is selected and click Next.
10. Select the Finish this formula option and click Next.
11. Click Finish. Your formula should read:
    \[
    \text{Sum} \left( \left[ \text{Attribute:Proposed_Buildings:Population} \right] \right)
    \]
12. Click OK to close the indicator creation window. Note that a new chart has been created. If your charts view is not open, click the View Charts button on the Scenario 360 toolbar.

Creating the Employees indicator

1. Create a new indicator named Employees. Use the General category, and set the decimal places to 0.
2. In the Description field, type Total number of employees (retail and office).
3. Click to place a checkmark next to Add this indicator to an existing chart then click the Select Charts button.
4. Click to select Population from the chart list and click OK.
5. Click the **Formula** tab then click the **Formula Wizard** button.
6. Select **Add the values of an attribute** and click **Next**.
7. Click to select **Proposed_Buildings** from the **Select Layer** drop-down list.
8. Click to select **Retail Employees** from the **Select attribute to sum** drop-down list.
9. Ensure the **sum all features in Proposed_Buildings** option is selected and click **Next**.
10. Click to select the **Include additional calculations or values in this formula** option and click **Next**.
11. Select **Add the values of an attribute** and click **Next**.
12. Click to select **Proposed_Buildings** from the **Select Layer** drop-down list.
13. Click to select **Office Employees** from the **Select attribute to sum** drop-down list.
14. Ensure the **sum all features in Proposed_Buildings** option is selected and click **Next**.
15. Select the **Finish this formula** option and click **Next**.
16. Click **Finish**. Your formula should read:
   
   \[\text{Sum} \left(\text{Attribute:Proposed_Buildings:Retail Employees}\right) + \text{Sum} \left(\text{Attribute:Proposed_Buildings:Office Employees}\right)\]

18. Click **OK** to close the indicator creation window. Note that the employees chart information has been added to the population chart.

**Creating the Construction Cost indicator and alert**

1. Click once to select the **Population** indicator in your indicators setup list then click the **Duplicate** button.
2. Create a new indicator named **Construction Cost**. Use the **Construction Cost** category, and set the decimal places to **0**.
3. In the **Description** field, type **Total cost of construction**.
4. Edit the formula so that it reads:
   
   \[\text{Sum} \left(\text{Attribute:Proposed_Buildings:Construction Cost}\right)\]

5. Remember to check your formula before clicking **OK**.
6. Click the **Alerts** tab, then click **New**. Use the information provided in the image below to create your new alert.

7. Click **OK** to close the alert creation window.
8. Click **OK** to close the indicator creation window.
9. Close the indicators list.
Creating and editing indicator charts
Charts are dynamically linked to indicators and attributes. As changes are made in the analysis, chart displaying values for indicators or attributes will update automatically to reflect analysis results. You created an attribute chart earlier in this tutorial (floor space ratios). You will now create a new indicator chart and edit a previously created chart so you can easily view changes and make comparisons in your analysis.

Creating a chart with a threshold line to track the total cost of construction
1. Click once on Charts on the 360 Setup tab Work Flow view.
2. Create a new chart named Construction Cost. Use the Bar type and set the decimal places to 0.
3. Click the Data tab and click the Add Indicator button.
4. Click once on Construction Cost to select it, then click OK.
5. Click the Axes tab, click to remove the checkmark next to Label, type 0 as the Minimum, and type 100000000 (hint: eight 0s) as the Maximum.
6. Click to select the Increment option and type 100000 (hint: five 0s) as the increment. Click the Threshold Lines tab. Note that the alert you set when you created your indicator created a threshold line in your chart.

Adding an item line to the chart
1. Click the Item Lines tab
2. To add a line whose position shows the value of an indicator or assumption, use the Add Indicator or Add Assumption button. To add a line with a set value, use the Add Custom button. Fill in the position which refers to the value of the line on the vertical Y-axis and choose the color. The line will be added. Notice that it is a dashed line.
3. Click OK to close the create chart window. Your new chart will be added to the list.

Editing the Population chart
1. Click once to select the Population chart on the charts list then click the Properties button.
2. In the Name field, type Employees and Population then set the Decimal places to 0.
3. Click the Axes tab, ensure there is no checkmark next to Label, and type 0 as the Minimum and 5000 as the Maximum.
4. Click to select the Increment option and type 100 as the increment.
5. Click OK to close the chart creation window. Your new chart will be added to the list.
6. Close the charts list and save your analysis.

Experimenting with assumptions
During assumption setup, you divided the building type ratio at 70% residential, 20% office, and 10% retail for the base scenario. Changing these assumptions will dynamically change the population balance and the construction costs. Note that the way this formula is set up, there is nothing stopping you from making the ratios add up to more than 100%. The pie chart you created will continue to display the relative ratios.

1. Make sure the charts view is open. If it is not, click the View Charts button on the Scenario 360 toolbar.
2. Click once on Assumptions on the 360 Analysis tab to display the graphical view of the assumptions.
3. Increase the Office Ratio assumption value to 60%.
4. Decrease the Residential Ratio value to 30%.
5. Click the **Apply Assumption Changes** button. Scenario 360 will update the scenario and dynamically change the indicators, the results of which are displayed on the charts. Increasing the office ratio while decreasing the residential ratio will increase the population and construction costs. If your construction budget exceeded 60,000,000, the alert you set will be triggered and the chart bar will turn red.

6. Notice the gray diagonal lines on the bar graph indicating the previous values. Hover your mouse over one of the bars on the chart to display a pop-up information window.

7. When you are finished, close the Assumptions window and click **No** when asked whether you want to save assumption changes.

8. To revert to the original default settings on the charts, click the **Options** button on each chart and select **Clear Previous Values**.

**Adding new buildings and modifying building stories**

In this exercise, you are considering adding another building to the development project. However, your budget is limited. How much space can you add? In Scenario 360, you can find out simply and see the results of the additional space immediately.

**Construction Budget**

The bar graph for construction costs should look similar to the one illustrated here (you may have different values). Note the red threshold line at the $60,000,000 level.
1. Start an editing session by clicking once on Start Edit on the 360 Analysis tab.

2. Click on the Sketch Tool on the ArcMap Edit toolbar. Make sure the Task drop-down list has Create New Feature selected and that the Target drop-down list has Proposed Buildings selected.

3. Draw a new polygon to represent a potential new building (see image below). When you have finished creating the four points, double-click on the last point to complete the polygon.

4. When prompted, type 6 in the Stories field and click OK. Notice that this building does not have a dark red line around it. This is because it does not cross the threshold you set for number of stories (it is not > 10 stories).

5. The six-story building probably caused the Construction Cost chart to change the bar to red because the cost exceeded your budget. Your budget will not allow for an additional six-story building of that size. The target line was exceeded and an alert was triggered.
6. Click the **List Alerts** button on the Scenario 360 toolbar to view your alerts.

7. Do not stop your editing session at this time.

**Modifying building stories**

1. Click the **Edit Tool** on the ArcMap Editor toolbar then click once to select the eleven-story building you previously created (the one displaying the alert).

2. Click the **View and Change Feature Attributes** button on the Scenario 360 toolbar.

3. Double-click on the **Stories** property and, when prompted, enter 3 in the **Stories** field.
4. Click OK. The program will update the indicators and associated charts.

5. Close the Attributes table, click Stop Edit on the 360 Analysis tab, and click Yes when asked whether you want to save changes.

6. Click the List Alerts button on the Scenario 360 toolbar then click the Clear All Alerts button.

Viewing a diagram of the analysis components and relationships

You can view and share detailed graphic analysis diagrams that use flow chart-style lines and icons to illustrate the logical relationships between components of your analysis. For example, you can quickly see which indicators depend on a particular assumption by looking at the connections displayed on the diagram. Let’s explore the components and their relationships in this analysis.

1. Click the 360 Analysis tab Diagram icon or the Diagram toolbar button on the Scenario 360 toolbar to display a diagram of the analysis.

2. Examine the diagram for this analysis and the component relationships you created.

3. Explore the options available when you right-click on any component.
   - View connections for a specific component.
   - Show all inputs or dependents of a specific component.
   - Expand or collapse components in the layout for viewing purposes.
   - View and edit analysis component properties.
   - View and edit current values for assumptions, indicators, and charts.

4. If you chose to view connections to a specific component in your analysis, you can switch back to viewing the entire analysis using the Show Entire Analysis button.

5. Practice using the Interactive Zoom Tool button to zoom in or out. Click this button then click and move the mouse cursor up or down in the diagram layout.

6. Practice using the Marquee Zoom Tool button. Click and drag a box around components to zoom in on that area of the diagram layout.
Viewing this analysis in 3D
Even if you don’t have SiteBuilder 3D, you can explore and fly through a sharable 3D scene depicting Community City. Copy the Sharable 3D Scenes folder from the Resource Disk to your hard drive and double-click on the sbviewer.exe file in the Community City folder. After several moments, the 3D viewer will open.

For instructions on viewing sharable 3D scenes, see the separate instructions on your Resource Disk.

Exploring further
This is the end of the tutorial exercises for Community City, but you should feel free to experiment and explore further. For example:

- Using the options available on the 360 Analysis tab, try changing the persons per dwelling unit assumption, or editing values in the lookup table. Practice editing the proposed buildings – change their shapes, change the number of stories, move, and delete buildings (all of these functions are available on the ArcMap Editor toolbar). Picture the development you would like to see and try to make it come in under budget and maintain a roughly even jobs to population ratio.
- Try creating a report for this analysis.
- Use the Scenario Comparison window to create a view you think would effectively convey the main points of this analysis to a large audience.

Congratulations – you have completed Tutorial 3
You have successfully completed creating a new analysis and base scenario for My City. The next tutorial will show you how to use SiteBuilder 3D. After you have completed the SiteBuilder 3D tutorial, you might want to try repeating the exercise using your data from Community City.
Tutorial 4 – Working with SiteBuilder 3D

The following tutorial contains a series of exercises that demonstrate how to use SiteBuilder 3D to create realistic, populated 3D views. You will create a base terrain by adding layers, drape a texture over it, add features, and view the 3D results in real time. In addition, you will make a travel path using eyepoints and control points and record these points in a movie file. Finally, you will export your scene in a format that anyone can use to explore and fly through interactively.

Starting a new analysis

In this exercise, you will create a new empty analysis.

1. If you haven’t already, start Scenario 360 by double-clicking on the Scenario 360 icon on your desktop. If Scenario 360 is open, click the Scenario 360 menu, point to Analysis, and click New on the Scenario 360 toolbar. If you had a previous analysis open, you will be prompted to save your changes.

2. Select Create new empty analysis and click Next.

3. In the Analysis Name field, type SB3D_Tutorial and click Next.

4. In the Description field, type My practice 3D analysis and click Next.

5. Accept Base Scenario as the base scenario name.

6. Leave the Description field for the Base Scenario blank and click Next.

7. Click Finish. Scenario 360 will update your files and create your new analysis folders.

Setting your data frame properties

Now, set your data frame properties, as follows:

1. Click the ArcMap View menu then click Data Frame Properties.

2. Click the Coordinate System tab.

3. Browse to the Predefined\Projected Coordinate Systems\Utm\Nad 1983\NAD 1983 UTM Zone 10N file, click once on it to select it and click OK.
Adding data to your analysis
Now you are ready to start adding data to your analysis.

1. Click the **360 Setup** tab **Work Flow** view.
2. Click once on **Data** to open the data list.
3. Click the **Add Data** button.
4. Select **Existing Data Layer** and click **Continue**.
5. Browse to **Program Files\Multigen-Paradigm\resources\tutorials\sitebuilder3d_forArcGIS\site_creation_tutorial\images** folder, click once on **tutorial.tif** and click **Add**.
6. If warned that one or more layers is missing spatial reference information, click **OK**. If prompted to select pyramids, select **Build pyramids** –OR– **Always build pyramids and don’t show this dialog in the future** then click **OK**. A rasterized TIF image will be added to your map view and tutorial.tif will be added to the ArcMap table of contents.

9. Next, you will add the shapefiles to your analysis. Click the **Add Data** button.
10. Select **Existing Data Layer** and click **Continue**.
11. The folder you selected in step 6 will reappear, pointing to the **site_creation_tutorial\images** folder.
   Click the **button to move up one level, then double-click the **shapefiles** folder.
12. While holding down the **Shift** key, click to select all four available data layers, then click **Add**. Scenario 360 will add these four data layers to your analysis and display them in your map view.

13. Close the Data list.
14. Make sure that the items in the ArcMap table of contents are turned on (click to place a checkmark next to their name).
Creating the base terrain

In this part of the tutorial, you will use the 2D elevation data that you loaded to create a base terrain and view it. SiteBuilder 3D creates a base terrain from an ArcView feature theme (point, line, or polygon) with elevation data, a grid theme, or a Triangulated Irregular Network (TIN).

1. If the SiteBuilder 3D toolbar is not available, click the ArcMap View menu, point to Toolbars and click SiteBuilder 3D. If the toolbar buttons are grayed out and unusable, make sure SiteBuilder 3D is licensed on your computer and that the SiteBuilder 3D extension has been enabled in the ArcMap Tools menu Extensions option.

2. Click SiteBuilder 3D on the SiteBuilder 3D toolbar, point to Create Terrain, and click Create Terrain From Features.

3. Click OK on the Browse for Folder window.

4. Click the checkbox beside elev-pts for the Layer.

5. Click the Height Source drop-down and select Z_VALUE.

6. Accept the Feature Type and Tolerance settings and click OK. The program will save this information in the CVFiles\SB3D_Tutorial\3D folder.
Applying texture to the terrain

Now that you have created a terrain base skin, you can apply a texture to it to give it a realistic appearance. SiteBuilder 3D offers two methods:

- You can use an existing image file that has been loaded as a layer.
- You can apply a texture that has been created from the current image in ArcMap.

Base terrain is made up of polygons that simulate the contours of the earth at the location you created. Since the polygons that make up the base terrain are the same color, the terrain viewed in 3D lacks realism. To give your base terrain a real world look and feel you must apply a texture. Textures provide depth and detail, and can be used in place of features for some visual detail. Terrain textures are TIFF images that have been mapped to the extents of the terrain. The sources for these images are usually geo-referenced satellite or aerial photos (such as tutorial.tif), however you can use any TIFF image.

Draping a texture from display

1. Turn off (uncheck) all layers in the ArcMap table of contents except for tutorial.tif (turn off pines, elev-pts, roads, and bldg-foot).
2. Click SiteBuilder 3D on the SiteBuilder 3D toolbar, point to Drape Texture, and click Drape Texture from Display.
3. In the Browse for Folder dialog box, navigate to the folder in which to save the texture file. For this exercise, use the same path as the terrain files (CVFiles\SB3D_Tutorial\3D) then click OK.
4. SiteBuilder 3D estimates the file size, checks to see if you have sufficient hard drive space, then prompts you to continue creating the texture. Click Yes to continue. A progress bar lets you know when the program has completed the process. If you receive an error message that that the display is too small, make the ArcMap window larger and repeat the procedure.

Viewing your terrain in 3D

In the following exercise, you will display the 3D Viewer and use the mouse buttons to navigate around in the 3D view.

1. Click the Launch 3D Viewer button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.
2. Drag the window so that both the Scenario 360 window and the 3D Viewer are visible. A red view cone appears in the ArcMap window when you open the 3D Viewer. The view cone represents your eyepoint in the 3D Viewer. The eyepoint originates at the apex of the cone and looks out through the opposite end of the cone. If the view cone is not visible, click the Toggle the ViewCone button on the SiteBuilder 3D toolbar.
3. In the 3D Viewer, click the Motion menu, point to Speed, and click 3X. The default motion mode is Fly Mode.
4. Practice flying around the view by using your mouse buttons. Point where you want to go and hold down the mouse button. The chart below provides some navigation methods using a three-button mouse.

<table>
<thead>
<tr>
<th>Mouse Button</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left mouse</td>
<td>Moves forward.</td>
</tr>
<tr>
<td>Middle mouse</td>
<td>Pans the eyepoint up and down, or pans left and right; position is stationary.</td>
</tr>
<tr>
<td>Right mouse</td>
<td>Moves in reverse.</td>
</tr>
<tr>
<td>Shift+R</td>
<td>Resets the eyepoint to its starting position.</td>
</tr>
<tr>
<td>All three mouse buttons</td>
<td>Resets the eyepoint to the position where the motion model was last changed.</td>
</tr>
</tbody>
</table>

The Status bar at the bottom of the 3D Viewer displays the current motion mode, the current speed (S), overall altitude (Z), and heading (H).

| Mode : Fly | S: 3.00 | Z: 787.77 | H: 37.92 |

Notice how these speed, altitude, and heading figures change as you move through your 3D view. If you size the 3D Viewer too small, all of the Status bar may be not be visible. Make the window larger to see the entire Status bar.
5. As you move through the 3D view, notice how the view cone tracks your movement in the ArcMap window.
6. Close the 3D Viewer by choosing File > Close.

**Planting features on the 3D terrain**

Using SiteBuilder 3D, you can place feature layers from ArcMap into the 3D view. Features represent trees, buildings, roads, etc., which are already present in the view. In the following exercises, you will use the **3D Legend Editor** to define placement preferences for each of the feature layers that you place onto the terrain. You will build the features and view the populated scene.

**Placing a point feature**

1. Click the ArcMap File menu then click **Save** to save your project.
2. Click the **3D Legend Editor** button on the SiteBuilder 3D toolbar.
3. Click the Layer drop-down list and select **pines**.
4. Click the icon next to **Point - Point substitution for OpenFlight model** (see image right). This will open the Place Parameters window which will allow you to define how the point feature is to be placed on the terrain.
5. In the **Model (flight file)** field, choose **Single Value**. The field to the right displays an arrow button. Click the arrow button to open the **Model Selector** window.
6. In the **Model Selector** window, click the **Model Librarian** button to open the **Model Librarian** window. If you can’t see the window, click on the Model Librarian button on your Windows task bar (usually located at the bottom or your screen). Click **Vegetation**, browse the selection of trees and drag a tree of your choice to the **Select Single Mode** field in the **Model Selector** window.

7. Close the **Model Librarian** window.
8. Click **OK** to in the **Model Selector** window.
9. Click the **Model Orientation** drop-down list and select **Single Value**. Accept the value of **0.00**.
10. Click the **Model Scale** drop-down list and select **Single Value**. Accept the value of **1.00**.
11. Click the **Save** button.
12. Click the **Build** button to place the pine tree models into the scene. SiteBuilder 3D substitutes OpenFlight models for the existing point features and displays the pine trees in the 3D Viewer.
13. Click the **Launch 3D Viewer** button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer. If you see a message about points outside of the base terrain layer, Click **OK**.

### Placing a line feature

1. Click the **3D Legend Editor** button on the SiteBuilder 3D toolbar.
2. Click the **Layer** drop-down list and select **roads**.
3. Click the icon next to **Ribbon - Surface conforming linear with width and no height (e.g., road)** (see image right). This will allow you to define how the line feature is to be placed on the terrain.
4. Click the **Width** drop-down list and select **Value Field**. Click the next drop-down list and select **WIDTH**.
5. Click the **3D Symbol** drop-down list and select **Color**.
6. In the **Offset Height** field, choose **Single Value**, and set the field value to **0.20**.

7. Click the **Save** button.
8. Click the **Build** button to place the roads into the scene.
9. Click the **Launch 3D Viewer** button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.
10. Close the 3D Viewer.
Placing a polygon feature

When placing polygon feature layers onto the 3D terrain SiteBuilder 3D provides you with several options:

- You can choose to substitute a 3D model for each feature in the layer
- You can substitute a three-dimensional polygon that has color or texture attributes associated with it
- You can apply the same color or texture to all the features in the layer
- You can give the features a more realistic look by using color or texture schemes

Schemes apply different colors or textures to a field in a layer’s attribute table based on the field value. Schemes are similar to thematic maps in ArcMap. For example, you can apply colors to a polygon feature layer by building type, where industrial buildings have one set of colors and office buildings have a different set of colors. You apply a scheme by associating the 3D symbol attribute to a field in the layer table.

Placing a polygon layer using a color scheme

1. Click the 3D Legend Editor button on the SiteBuilder 3D toolbar.
2. Click the Layer drop-down list and select bldg-foot.
3. Click the icon next to Flat Box - Surface extruding polygon with a top and sides (e.g., building footprint). This will allow you to define how the line feature is to be placed on the terrain.
4. Click the Height drop-down list, select Value Field. In the next drop-down list, select HEIGHT from the drop-down list.
5. Click the 3D Symbol drop-down list, select Color, then click the Select Color button.
6. Click the Legend Type drop-down list and select Value Field.
7. Click the Value Fields drop-down list, scroll down, and select Category. Click OK.
The field values update to display the zoning or type of building classification of each building represented in the layer. Top and side color patterns appear next to each field value. These colors will be applied to the extruded shapes when they are placed on the base terrain. SiteBuilder 3D provides several color schemes based on type - Commercial, Housing, Industrial, and so on.

8. Click the **Save** button.
9. Click the **Build** button to place the building models into the scene. SiteBuilder 3D substitutes OpenFlight models for the existing polygon features and displays the buildings in the 3D Viewer.
10. Click the **Launch 3D Viewer** button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.

You can now explore the 3D view you have created. If you get lost while moving, simultaneously press all three mouse buttons to reset the view to where you started.

**Adding environmental effects**

Adding environmental effects, such as Fog or Clouds, to your 3D view makes it more realistic. The program sets Fog as the default effect. You can also adjust the lighting to reflect different times of the day or night. To do this, change the time of day in your 3D view.

1. If you closed the 3D Viewer, click the **Launch 3D Viewer** button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.
2. In the 3D Viewer, click the **Environment** menu then click **Time of Day**.
3. Drag the slider back and forth and watch the scene as it updates instantly. Return it to the **Day** setting and click **OK** to close the control.
4. Click the **Environment** menu then click **Fog Properties**. Try changing the color of the fog by clicking on the color swatch, choosing a new color, and clicking **OK**. Click **Cancel** to return to the original setting.
5. Reopen **Fog Properties**. Set the fog range to about 1000, and click **OK**.
6. Click the **Environment** menu then click **Fog** to turn on the fog, if it is not on already (if the item is checked, fog is on). If you cannot see the terrain when the fog is on, move your eyepoint closer to the terrain or set the fog range higher.
7. Click the **Environment** then click **Fog** to turn off the fog.

**Creating a virtual tour and a movie**

You can take viewers on a visual tour of your 3D view by either saving a series of eyepoint locations or control points along a path and then playing them back. You can play back the saved eyepoints immediately by switching the view to the new eyepoint, or gradually by flying in a straight line from one eyepoint to the next. Eyepoints are not visible in the 3D Viewer.

You can use control points to create a travel path. You can interactively move and edit control points to change your path. Control points are visible in the 3D Viewer.

You can record and save both eyepoint paths and control point as a movie file and played back in the Windows Media Player or other media players.
Setting eyepoints for the virtual tour

Eyepoints are one way to set a path. Eyepoints are not visible in the 3D Viewer and their position cannot be moved, unlike control points.

The saved eyepoints can be played back immediately by switching the view to the new eyepoint, or gradually by flying in a straight line from one eyepoint to the next.

1. If you closed the 3D Viewer, click the Launch 3D Viewer button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.
2. Position yourself to the place where you would like to set your eyepoint. The view cone in the ArcMap map view represents your eyepoint in the 3D Viewer. The eyepoint originates at the apex of the cone and looks out through the opposite end of the cone. Click the Eyepoints menu then click Edit Eyepoint.
3. Click the Get Current Pos button to read the location of the eyepoint.
4. Click the Add New button.
5. Enter the name Start for the eyepoint and click OK.

6. Move to the location of the next eyepoint. Repeat steps 3 through step 6 for each eyepoint location. Set at least five eyepoint locations, each with a unique name.
7. After you set eyepoints, click OK to save the settings and close the New Eyepoint dialog box.
8. Click Yes in the Save Eyepoints dialog box to save your eyepoints.
9. Click the Eyepoints menu then click Go To Next or use the keyboard shortcut Ctrl+Shift+E to go to each eyepoint.
10. Click the Eyepoints menu then click Fly To Next (Ctrl+Shift+F) to see what happens when you fly to the eyepoints instead.

For this tutorial, you will not make a movie file from this eyepoint path. Instead, we will create a path using control points and then make a movie file from that path.
Setting control points for the movie file
Control points are the other way to set paths. Control points are visible in the 3D view and you can move their position, unlike eyepoints.

1. Make sure your are in Fly Mode (click the Motion menu then click Fly Mode).
2. Position yourself to the place where you would like to set your control point. Click the N key to open the Quick Path Properties dialog box.
3. Accept all the default settings. The path will be a Loop Path, which loops indefinitely until you stop it. Click OK. The first control point is created at the current position. This control point will remain blue to indicate your starting position.
4. Fly around the 3D view to the next location on your path, and press the N key to create a new control point. The successive control points after the starting blue position are yellow. Move to different areas in the 3D view to set each control point on the path. Set at least four control points.
5. To set the last control point, press Shift+N. A message displays the number of control points created and the path name.
6. Click OK to return to the 3D view.
7. Click the Paths menu then click Follow to follow the path. Notice that the path loops indefinitely.
8. To stop the path, click the Paths menu then click Stop Path. To pause, press the Space bar.

Recording a movie
You can make control points and eyepoints into a movie file. Movie files are a good way to capture your 3D view and share it with others.

To record a movie, use the following procedure:

1. If you closed the 3D Viewer, click the Launch 3D Viewer button on the SiteBuilder 3D toolbar to view the scene in the 3D Viewer.
2. Click the Paths menu then click Movie Properties.
3. Click the Default button to record the entire length of the path of control points you created in the last exercise.
4. Click the Set the Media Player button to select Windows Media Player (wmplayer.exe) and click OK.
5. Click the Record Movie button. The 3D Viewer resizes to the default output size of the movie specified in the Movie Properties dialog box.
6. In the MPI Video Compression Options dialog box that appears, leave the default compressor settings for your media player. The recording is compressed into an .avi file format according to the compression ratio. Click OK to start recording the movie. The program automatically follows the path around one loop. Be patient as the program takes individual images through your loop.
7. When the recording reaches the end of the path, a dialog box appears that shows the details of the recording. Click the Play Last Movie button to launch the movie in the Windows Media Player. Mouse over the upper edge of the media player window and click File. Browse to the SiteBuilder 3D movie clip file (this file should be located in the SB3D_Tutorial\3D folder). Double-click the file to play your movie.
Creating sharable 3D scenes
SiteBuilder 3D users can save 3D scenes in a portable format that can be used on other computers. Friends and colleagues can fly through and explore 3D scenes at no charge and without needing to install any special software.

Shared 3D scenes are transported as a directory containing folders and files. You can share your 3D scenes with others by having them download the directory and its contents via the internet or by providing them with a CD or a .zip file.

Instruction on working with CommunityViz shared 3D scenes can be found on the Resource Disk included with the Scenario 360 software. Feel free to distribute this helpful document (Working with CommunityViz shared 3D scenes.pdf) with your shared 3D scene to assist users in working with the scene and moving around in the 3D environment.

Create your own sharable 3D scenes by doing the following:
1. Create your 3D scene. For this exercise, you will use the scene you created in the tutorial.
2. Create a new folder on your C:\ drive called Viewer (when not working in the tutorial exercises, you can choose any name and any location you wish).
3. Click the Create sharable 3D scene button on the SiteBuilder toolbar.
4. Browse to the new C:\Viewer folder and click OK. A sharable 3D scene is created in the Viewer directory. The 3D scene is saved complete with the viewer in the terrain folder.
5. You can burn the contents of this folder to a CD, upload the folder and contents to an FTP or internet site, or .zip the folder and contents to share it with other users.
6. Those that you share the 3D scene with can launch the 3D scene by double-clicking the sbviewer.exe file in the terrain folder.

Congratulations – you have completed Tutorial 4
This concludes the tutorial for SiteBuilder 3D. You have added data, created a terrain, applied a texture to the terrain, added features, and created a virtual tour and a sharable 3D scene.
Tutorial 5 – Setting up and running a build-out analysis

This tutorial walks you through creating and running a detailed build-out analysis. For a simpler introduction to the basics of build-out, use Tutorial 1.

**Build-out analyses** allow planners to estimate the amount and location of development for an area. Performing a build-out analysis is the step in the community planning process that identifies the holding capacity of the land in terms of buildings and/or floor space. Build-out is a supply-side calculation applied to a clearly delineated area that is based on assumptions for density, physical constraints to development, and land-use regulations that define the size and placement of structures for that area.

A build-out analysis provides an answer to the question “how many buildings could be built in this area according to current land-use regulations?” A build-out analysis provides a convenient reference for future planning because it represents a theoretical maximum. It does not imply or forecast how many buildings will actually be built.

In this fictional example, you will run a build-out analysis on a study area containing multiple land-use designations.

Once installed using the “Install the tutorial data” directions on page 1, you will find this analysis in the CVFiles\Build Out folder. For detailed information on build-out, please see the “Working with the Build-Out Wizard” document on the Resource Disk that shipped with your software.

**Data requirements for Build-Out**

Before running a Build-Out, you will need:

- A land-use layer (like a zoning map, master land-use plan, or a parcel map).
- This land-use layer must be a projected coordinate system as opposed to a geographic coordinate system. More information on coordinate systems can be found in ArcMap’s help or at the ArcGIS website.
- The land-use layer must have an attribute that specifies the land-use designation (like zoning type, permitted use description, or land-use code) as a text field (not numeric) and cannot exceed 100 characters.
- The land-use layer must have an attribute that specifies the unique identifier of each land-use area (like feature ID or parcel number).

You will be prompted for this information as you move through the Build-Out Wizard.

**About build-out analysis**

A build-out analysis is one the many kinds of analyses that are possible with Scenario 360. In the fictional study area, differing land-use designations will be considered for future planning. The build-out process contains 3 separate, but integrated steps: numeric, spatial, and visual. In this tutorial, you will experiment with all three.

**Objective**

- Estimate how many buildings could be built in the study area according to current land-use regulations.
- Place the estimated building points in your map view while taking into account the actual geometry of land-use areas and buildings.
- Visualize the buildings in 3D.

**Constraint**

Proximity to wetlands environmental area.
Opening an existing analysis

1. If you haven’t already, start Scenario 360 by double-clicking on the Scenario 360 icon on your desktop. If Scenario 360 is open, click the **Start a Scenario 360 Analysis** button on the Scenario 360 toolbar.

2. On the Welcome to Scenario 360 window, click **Open Existing Analysis**.

3. Browse to the **CVFiles/Build Out** file, click the file, and click **OK**. If you had a previous analysis open, you will be prompted to save your changes.

Scenario 360 will load and display a fictional study area being considered for development. This area displays eight land use designations:

- Low Density Residential
- High Density Residential
- Mixed Use A
- Mixed Use B
- Mixed Use C
- Commercial
- Municipal
- Park/Openspace
The land-use rules for this fictional analysis are included in the table below. In this tutorial, you will be walked through entering this information into the Build-Out Wizard to run your build-out analysis.

<table>
<thead>
<tr>
<th>Land-Use Designation</th>
<th>Density</th>
<th>Mixed Use</th>
<th>Building Info</th>
<th>Min Separation Distance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Commercial</td>
<td>.25 FAR</td>
<td></td>
<td>0 DU/Building 10000 sq. ft. 1 floor</td>
<td>100 feet</td>
</tr>
<tr>
<td>High Density Residential</td>
<td>14 DU/acre 80% efficiency</td>
<td></td>
<td>6 DU/Building 4 floors</td>
<td>80 feet</td>
</tr>
<tr>
<td>Low Density Residential</td>
<td>0 DU/acre (already built)</td>
<td></td>
<td>0 DU/Building 0 floors</td>
<td>0 feet</td>
</tr>
<tr>
<td>Mixed Use A</td>
<td>3 DU/acre .2 FAR 50/50 % split</td>
<td></td>
<td>1 DU/Building 1400 sq. ft. 3 floors</td>
<td>80 feet</td>
</tr>
<tr>
<td>Mixed Use B</td>
<td>.65 FAR</td>
<td>Apartments = 30% and 1200 sq. ft Retail = 20% Office = 50%</td>
<td>0 DU/building 2800 sq. ft. 5 floors</td>
<td>80 feet</td>
</tr>
<tr>
<td>Mixed Use C</td>
<td>.3 FAR</td>
<td>Apartments = 75% and 1000 sq ft Retail = 25%</td>
<td>0 DU/Building 4000 sq. ft. 2 floors</td>
<td>100 feet</td>
</tr>
<tr>
<td>Municipal</td>
<td>.3 FAR</td>
<td></td>
<td>0 DU/Building 3 floors</td>
<td>40 feet</td>
</tr>
<tr>
<td>Parks/Openspace</td>
<td>0 DU/Building 0 floors</td>
<td></td>
<td></td>
<td>0</td>
</tr>
</tbody>
</table>
Opening the Build-Out Wizard
The Scenario 360 Build-Out Wizard automates the entire build-out process. It guides you through the choices and selections that will form the basis of your build-out analysis. You can access the Build-Out Wizard using the Scenario 360 toolbar. Click the Scenario 360 drop-down list, point to Tools, and click Build-Out Wizard.

Setting up a numeric build-out analysis
For a numeric build-out analysis, the Build-Out Wizard will calculate the estimated building capacity (in numbers) for each polygon in an area.

1. Open the Build-Out Wizard.
2. Click the Numeric button.

Specifying land-use information
When following the numeric Build-Out Wizard steps, you will be prompted to specify:
- A land-use layer (like a zoning map, master land-use plan, or a parcel map). This must be a projected coordinate system (as opposed to a geographic coordinate system). For information on coordinate systems, see ArcMap help.
- The attribute in that layer that specifies the land-use designation (like zoning type, permitted use description, or land-use code). This must be a text field (not numeric) and cannot exceed 100 characters.
- The attribute that specifies the unique identifier of each land-use area (like feature ID or parcel number).

In this tutorial, the data has been set up for you.

1. On the Specify Land Use Layer screen, ensure that Land Use is selected as the layer containing land use information;
2. The attribute specifying land-use designation should read LU_Designation.
3. The attribute specifying the unique identifier of each land-use area should read OBJECTID.
4. Preview the land-use designations in the field provided, then click Next.

Setting up density rules
Density is an indication of the number of buildings per unit area. Attributes specifying land-use designations may contain fields that describe the permitted (or projected or planned) densities in each polygon. For residential polygons, density is often provided in dwelling units per area, number of dwelling units, or minimum lot size per area. For nonresidential polygons, density is usually provided in floor area or by using a floor area ratio (FAR). If these fields are not provided, you may enter numbers for each land-use type in the Build-Out Wizard, or use the default values suggested by the Wizard.

1. Either type or click and select from a provided drop-down list to fill in the fields with the information shown in the image below:

<table>
<thead>
<tr>
<th>Designation</th>
<th>Dwelling Units</th>
<th>Floor Area</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Quantity</td>
<td>Measurement</td>
</tr>
<tr>
<td>Commercial</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>High Density Residential</td>
<td>14</td>
<td>DU per acre</td>
</tr>
<tr>
<td>Low Density Residential</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Mixed Use A</td>
<td>3</td>
<td>DU per acre</td>
</tr>
<tr>
<td>Mixed Use B</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Mixed Use C</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Municipal</td>
<td>0</td>
<td>None</td>
</tr>
</tbody>
</table>

2. Do not exit the Wizard or click Next at this time.

Using the FAR Estimator
Sometimes, land-use regulations don’t specify FAR but instead use other rules such as minimum set back from lot lines and maximum building height. The Build-Out Wizard includes a FAR Estimator to help you derive FAR from
other commonly used land-use rules. You will use the FAR Estimator to calculate FAR for the Mixed Use A and Municipal designations.

Calculating FAR for the Mixed Use A designation:
1. Click the FAR Estimator button on the Density Rules Wizard screen.
2. Click the Lot Size/Setback tab, click to place a checkmark next to Average lot size is sq. feet or sq. meters and type 1400 into the field provided. Note, the FAR Estimator does not need to know which measurement system (feet or meters) you are using, but you must be consistent.
3. Make sure there is a checkmark next to Building setbacks in sq. feet or sq. meters and type 30 in the field provided.
4. The FAR calculation at the bottom of the window should read .2.
5. Click to select Mixed Use A from the Apply to land-use designation drop-down list then click Apply.

Calculating FAR for the Municipal designation:
1. Click to remove the checkmarks on the Lot Size/Setback tab then click the Buildings tab.
2. Click to place a checkmark next to Maximum building heights and type 3 for the number of floors allowed.
3. Click to place a checkmark next to The building coverage ratio and type 10 in the field provided.
4. The FAR calculation should read .3.
5. Click to select Municipal from the Apply to land-use designation drop-down list then click Apply.
6. Click the Close button to close the FAR Estimator and view the FAR calculated for the Mixed Use A and Municipal designations on the Wizard screen. Verify that your numbers match those in the image below. Do not exit the Wizard or click Next at this time.

### Specifying mixed-use designations
Build-out can apply to residential dwelling units (DU) and/or commercial or mixed-use buildings. Mixed-use buildings can include both DU and commercial space. In your study area, Mixed Use A is a mixed-use land area with some all-residential buildings and some all-non-residential buildings. Mixed Use B includes mixed buildings with apartments, retail, and office space. Mixed Use C includes buildings with apartments and retail space. When using the Wizard for mixed-use buildings (as in these two examples), the number of dwelling units is specified in the mixed-use screens shown below – not in the density screens. This way, even though the density screen says 0 DU/acre, the residential units within mixed-use buildings will still be counted in your analysis.

1. Place a checkmark next to the link One or more designations include mixed-use buildings on the Density Rules Wizard screen and click Next.
2. In this analysis, two of your mixed use designations include mixed use buildings. Click to place a checkmark next to the Mixed Use B and Mixed Use C designations and click Next.
3. Make sure the units drop-down list under Floor Area per DU has sq. feet selected. Then, using the information provided in the image below, type the Building Use field information and the Percent of Floor Area per DU information for Mixed Use B in the fields provided.
4. Ensure that your building use percentages add up to 100% and click **Next**.

5. Make sure the units drop-down list under **Floor Area per DU** has **sq feet** is selected. Then, using the information provided in the image below, type the **Building Use** field information, the **Percent of Floor Area**, and the **Floor Area per DU** information for Mixed Use C in the fields provided.

6. Ensure that your building use percentages add up to 100% and click **Next**.

7. Because you entered both DU and FAR for the Mixed Use A designation, you must specify the percentages of land area that will be used for residential and commercial use. On the **Mixed-Use Percentages** Wizard screen, type **50** into the **Dwelling Units Percent** field and **50** into the **Floor Area Percent** field.

8. Click **Next**.

**Using efficiency factors**

Efficiency factors adjust density values to reflect common density losses. They are entered as a percentage where 100% means complete efficiency (no density lost), and 0% means no buildings will be estimated for that land use. In this fictional analysis, the High Density Residential designation requires 10% of the area to be dedicated to roads and 10% to schools. Therefore, you need to enter efficiency information for this designation.

1. Click to select the **Customize efficiency for each designation** option.
2. For the **High Density Residential** land-use designation, type **80** in the **Efficiency Percent** field and click **Next**.

**Entering building information**

The **Building Information** Wizard screen allows you to set up building size, dwelling units per building, and footprint of each building.

1. Make sure the units drop-down list under **Area** has **sq feet** selected.
2. Using the information provided in the image below, type the **DU per Building, Area** (in sq. feet), and the **Floors** in the fields provided then click **Next**. Again, note that Mixed Use B and C correctly show 0 DU per building because the details were specified elsewhere.
Specifying constraints to development

The “Constraints to Development” screen allows you to prevent development in particular places, such as a designated wetlands area or a right-of-way. For this example:

1. In the Available Layers list, click Wetlands, click the Add selected layer(s) to constraints button, then click Next.

The wizard also provides the ability to specify a minimum lot size, so that a polygon that is too small is not allowed to have any buildings. For this example you will not use that option.

Specifying existing buildings

If an area is zoned for 100 buildings but already contains 15, then you may want to limit your study to the 85 new buildings that are allowed. The build-out wizard can automatically subtract existing buildings from its results if you specify a point layer containing them. Normally each point is considered to be one dwelling unit, but if the layer contains attributes that specify a particular number of dwelling units per point, or a commercial floor area per point, you can use them here.

1. In the Available Layers list, click Existing Buildings, then click the Add selected layer(s) to existing buildings button.
2. In the Value or attribute specifying DU/bldg field, select DUs from the drop-down list.
3. In the Value or attribute specifying floor area measurement drop-down list, make sure sq feet is selected, then select FootPrntSF from the drop-down list in the field provided.
4. Click Next.

Running a numeric build-out analysis

You can run a numeric build-out analysis by itself or as the first step in running a spatial or visual build-out analysis. In this tutorial, you will run the numeric build-out, view the results, then continue on to spatial build-out.

1. Ensure the output units for the available floor area read sq feet.
2. Select the Finalize set up of numeric build-out and continue to the next step option and click Next.
3. Make sure that only Numeric is selected (it has a checkmark next to it) and click Run Build-Out.

Numeric build-out will now convert your land-use information (like density, design efficiency factors, and constraints to development) into numeric building counts. Running this numeric build-out analysis produced:

- Two new layers viewable in the Build-Out layer in the ArcMap table of contents. One is called Buildings and the other is Buildable Area. You can click and drag the Build-Out layer set beneath the Existing...
Buildings and Roads layers in the ArcMap table of contents to view existing buildings and roads in your map view.

- A Build-Out LandUses table. You can click the Source tab, right click on the Build-Out LandUses table and click Open on the pop-up menu to view the contents of this table.
- Six indicators. Click the List Indicators button on the Scenario 360 toolbar to view the new indicators.
- A Build-Out report. Click the List Reports button on the Scenario 360 toolbar then click on the report name to view the report.
- Three new charts: Build-Out Dwelling Units, Buildings, and Floor Area. Click the View Charts button on the Scenario 360 toolbar to open the charts view.
- A new Buildings Difference Buildable Area alert. Click the List Alerts button on the Scenario 360 toolbar then click Show all alerts to view the alert.

Setting up a spatial build-out analysis

Spatial build-out will create a new point or polygon layer representing individual buildings placed on the map according to your land-use rules. Spatial build-out can take a long time so it’s a good idea to try some initial experiments with a hundred buildings or less before working with larger numbers. Settings in the Spatial Layout window are vital to the final spatial build-out results.

Spatial build-out converts the numeric building counts into points representing individual structures. It then refines the numeric building counts by taking into account the actual geometry of land-use areas and buildings. For example, an oddly shaped lot may have enough total area for 2 buildings, but because of setback rules or
minimum separation distances, it may only fit 1 unit. You must first run a numeric build-out analysis (to get the numeric building counts) if you wish to run a spatial build-out analysis.

1. Open the Build-Out Wizard.
2. Click the Spatial button.

**Specifying building separation distances and choosing a layout pattern**

When setting up a spatial build-out analysis, you will be prompted to specify building minimum separation distance rules for your land-use designations. Building separation identifies the minimum distance required between building centroids.

The minimum separation distance defines the minimum distance between a new building point/polygon center and another existing or new building point or polygon center. Also, a new building point will be separated from its containing polygon’s edge by at least half the minimum separation distance. If you set the Minimum Separation Distance too large, no buildings will be allowed. Therefore it’s best to begin conservatively with a smaller distance that you can increase in later runs. Settings are retained from one run to another, so you can skip other windows that contain values you don’t want to change.

In choosing a Layout Pattern for the proposed buildings, “Random” is a good layout pattern to start with. If you use the Follow Roads layout pattern, you must specify a Setback distance. The setback is the exact distance from the road centerline to the building point or building polygon center. Setback distances are ignored when the grid or random layout pattern is used.

**Tip:** Setback distances should be greater than the distance from the road centerline to the edge of the land-use polygon. Otherwise, no building will be placed. Typical values are more than 20 feet. Setback distances should also be greater than half the minimum separation distance.

You have control over whether the spatial build-out building points are distributed in a random or grid pattern, or if you want the points to follow a road layer.

1. Make sure the units drop-down list under Minimum Separation Distance has feet selected.
2. Make sure the units drop-down list under Setback has feet selected.
3. Using the information in the image below, type or click and select from a provided drop-down list to fill in the
4. **Minimum Separation, Layout Pattern, Road or Line Layer, and Setback** fields.
Click Next twice.

Running a spatial build-out analysis

Each time you run a new build-out analysis on a given scenario, the old build-out analysis for that scenario will be overwritten. To explore and compare different alternatives without overwriting your previous results, you are given the option to create and use new scenarios in your analysis. For example, you may want to compare “build-out if we impose more restrictive zoning” versus “build-out if we create an enterprise zone”. In this tutorial, we will run each build-out step and overwrite the previous results.

1. Select the Finalize set up of numeric and spatial build-out and continue to the next step option.
2. Leave the slider bar at 100. This is a small study area and will not take a long time to process.
3. Click Next.
4. Select the Overwrite the current results option.
5. Make sure that only Numeric and Spatial are selected (they have a checkmark next to them) and click Run Build-Out.

Spatial build-out analysis results

Spatial build-out converts the building counts estimated during numeric build-out into points representing individual structures you can view on your 2D map. Potential building points are distributed two-dimensionally into each polygon one at a time. Spatial build-out places building points so that they avoid development constraints, other buildings, and polygon boundaries (land-use areas, zone districts, or lot lines). Spatial build-out analysis takes into account factors which cannot be accounted for in a numeric estimate, such as the minimum allowable offset between building or parcel shapes. Therefore, the results of spatial build-out are sometimes lower than the numbers derived in a numeric build-out.

Keep in mind the following when viewing the results of a spatial build-out analysis:

- A new building point will be separated from another new building point in the same polygon by at least the minimum offset distance specified for that polygon’s land-use class.
- A new building point will be offset from its containing polygon’s edge by at least half the minimum offset distance specified for that polygon’s land-use class.
- A new building point will be separated from any existing buildings by at least the minimum offset distance specified for that polygon’s land-use class.
- If a building does not appear in a polygon when you expect one to appear, or if fewer buildings are added than there is capacity, examine the attributes of the polygon. Was an estimated capacity correctly computed? Are there more existing buildings in the polygon already than there is capacity? Also, examine the dimensions of the polygon. Perhaps the minimum offset distance is too large.
- After spatial build-out has been run, you are free to edit the new buildings layer manually. You can add, move, or delete building points. This way you can turn a planning-level building pattern into more of a design-level distribution, with buildings following a uniform frontage line, etc.
Running this spatial build-out analysis:
- Populated fields in the **Buildable Area** attribute table and the **Build-Out LandUses** table. Right-click on the **Buildable Area** layer in the ArcMap table of contents and click **Open Attribute Table** to view the contents of this table. You can also click the **Source** tab, right-click on the **Build-Out LandUses** table and click **Open** on the pop-up menu to view the contents of this table.
- Added information to the **Build-Out** report.
- Updated the **Spatial** information in the charts created during numeric build-out.
- Triggered the **Buildings Difference Buildable Area** alert created during numeric build-out. Click the **List Alerts** button on the Scenario 360 toolbar, click to select the **Show only alerts that are currently active** option, then click **Run all alerts** to view the alert. The alerted area is displayed in the map view with a bold outline. It has been colored red in the image below to highlight the area.

### Setting up a visual build-out analysis

Spatial build-out placed the building points onto the 2D map. Visual build-out designates a building model (flight) file for those building points that can be viewed in a 3D scene. Therefore, you must first run spatial build-out (which requires you to run numeric build-out) before running a visual build-out.

There are three options for models that you can use with visual build-out.

A. Using models from the CommunityViz KMZ Model Library, suitable for viewing in Google Earth.
B. Using models created in Google SketchUp or downloaded from Google's 3D Warehouse, and also suitable for use with Google Earth
C. Using OpenFlight (.FLT) files like those in the CommunityViz 3D Model Library made for use with SiteBuilder 3D.
To learn more about these options, read this section. To continue with the tutorial, skip to the section "To conduct a visual build-out" below.

A. Using models from the CommunityViz KMZ Model Library:
The CommunityViz KMZ Library contains a useful collection of pre-made KMZ-format 3D models that can be used in Google Earth in conjunction with the CommunityViz Google Earth Exporter. Normally these files are installed in C:\CVFiles\3D Models\KMZ.

B. Using models created in Google SketchUp or downloaded from the 3D Warehouse:
Google operates a warehouse of 3D models provided by the public intended for public use. Go to:

http://sketchup.google.com/3dwarehouse/

At this website, you can search for a model representing the building type you desire, e.g. schoolhouse, and click on "Download to Google Sketchup." Once you are in Google Sketchup, export the image to a .KMZ file, saving it to the C:\CVFiles folder where your analysis is stored, e.g. C:\CVFiles\Sunny Vista. Later you will navigate to this location to use this image. Go to:

http://sketchup.google.com/

Once at this website, go to the "Downloads" tab where you can download the software Sketchup for free. Use the tutorials or Sketchup instructions to learn how to create your own model. Once satisfied with your model, export the model to a .KMZ format, saving it to your analysis folder, e.g. C:\CVFiles\Sunny Vista. Later you will navigate to this location to use this image.

B. Using OpenFlight files like those that come with SiteBuilder 3D.
The CommunityViz 3D Model Library for SiteBuilder 3D includes hundreds of models than can be used in visual build-out, including buildings, park benches, trees, and lamp posts. Instructions will be given below on where to locate these files. You can only view a visual build-out in 3D if SiteBuilder 3D is licensed on your workstation.

To conduct a visual build-out:
1. Open the Build-Out Wizard.
2. Click the Visual button.
3. Click once in the 3D Model field next to Commercial then click the Browse button.
4. Navigate to the location on your hard drive where your models are located.
   - To use the pre-made CommunityViz KMZ models (for use in Google Earth), go to C:\CVFiles\3D Models\KMZ.
   - If you saved SketchUp or 3D Warehouse models in your analysis folder, you can look there, e.g. C:\CVFiles\Sunny Vista\data.
   - If you intend to use OpenFlight (.flt) models provided with SiteBuilder 3D, go to C:\Program Files\Multigen-Paradigm\data\sitebuilder3d\ModelLibrary

Browse for a suitable building, click once to select it, and then click the Select button. Use the CTRL key to select multiple buildings.
5. Continue steps 3 and 4 for all of your building layers (you do not have to select a model for the Park/Openspace layer). When you have completed selecting models, click Next.

Running a visual build-out analysis
1. Select the Overwrite the current results option.
2. Make sure that Numeric, Spatial, and Visual are selected (they have a checkmark next to them) and click Run Build-Out.

Visual build-out analysis results
Visual build-out provides a convenient way to populate the 3D model file field in the buildings layer created during your spatial build-out analysis. You can use this field when you create a 3D model of your scene, as described in the SiteBuilder 3D Tutorial or the Google Earth Export Tutorial. You can use the 3D models generated by visual build-out in either SiteBuilder 3D or Google Earth, but not both at once. If you want to use both 3D tools, use another method for specifying which 3D model will be used for each build-out building.

Using visual build-out results in SiteBuilder 3D
The following steps provide a very brief walk-through of the procedure for taking advantage of your visual build-out results by building a simple scene in SiteBuilder 3D.

Creating the 3D view terrain
1. Click the SiteBuilder 3D drop-down list on the SiteBuilder 3D toolbar, point to Create Terrain, and select Create Terrain from Features.
2. Click OK to accept the Build-Out tutorial folder location.
3. Click to select the ContourLines layer.
4. Click the Height Source drop-down list and select Contour, then click OK.
5. Click to turn off all layers in ArcMap table of contents except the aerialphoto.tif layer (it should be the only one with a checkmark next to it).
6. Click the SiteBuilder 3D drop-down list on the SiteBuilder 3D toolbar, point to Drape Texture, and select Drape Texture from Display.
7. Click OK to accept the Build-Out tutorial folder location.
8. Click Yes to continue.

Assigning a model to the Existing Buildings layer
1. Click the 3D Legend Editor button on the SiteBuilder 3D toolbar.
2. Make sure Existing Buildings is selected in the Layer drop-down list and click the Place Method icon next to POINT.
3. Select Single Value from the Model (flight file) drop-down list. The field to the right displays an arrow button. Click the arrow button to open the Model Selector window.

   ![Model Selector Window]

4. In the Model Selector window, click the Model Librarian button to open the Model Librarian window. If you can’t see the window, click on the Model Librarian button on your Windows Task Bar (usually located at the bottom of your screen). Browse to and click once on the model you wish to use for your existing buildings then drag it to the Select Single Mode field in the Model Selector window.
5. Close the Model Librarian window.
6. Click OK to close the Model Selector window.
7. Click the Model Orientation drop-down list and select Single Value. Accept the value of 0.00.
8. Click the Model Scale drop-down list and select Single Value. Accept the value of 1.00.
9. Click the Save button then click the Build button to place the models into the scene.

Building your spatial build-out building models
1. Click the 3D Legend Editor button on the SiteBuilder 3D toolbar.
2. Select Buildings from the Layer drop-down list and click the Place Method icon next to POINT.
3. Select Value Field from the Model (flight file) drop-down list then select DDD_MODE_OL from the drop-down list to the right.
4. Click the **Model Orientation** drop-down list and select **Single Value**. Accept the value of **0.00**.
5. Click the **Model Scale** drop-down list and select **Single Value**. Type **1.25** into the value field.
6. Click the **Save** button.
7. Click **Yes** to overwrite the place table if prompted.
8. Click the **Build** button to place the models into the scene.

**Viewing your build-out analysis in 3D**

1. Click the **Launch 3D Viewer** button on the SiteBuilder 3D toolbar.
2. Remember, you can change your environment and motion using the menu options at the top of the 3D viewer.
3. You may have to turn off your **Fog** setting for best results.

---

**Exploring further**

This is the end of the programmed exercises for build-out, but you should feel free to experiment and explore further. You can go back to the Build-Out Wizard and change any of your values then re-run build-out to view your new results.

**Congratulations – you have completed Tutorial 5**

This tutorial has taken you through a sample build-out analysis using Scenario 360. You have set up and run numeric, spatial, and visual build-out on this analysis.
Tutorial 6 – Run an Analysis and Create a Presentation

This tutorial will walk you through several different ways of presenting your analyses which you can use in any combination. You will learn how to create clear, interactive, and impressive presentations using web-ready analyses, reports, and WebShots. In addition to these, consider viewing and sharing your analyses using the 3D visualization tools including SiteBuilder 3D (Tutorial 5) and the Google Earth Exporter (Tutorial 7).

In order to have results to present, the first step is to create an analysis using the skills you have learned in previous tutorials. Consider it a challenge!

A challenge: run and modify an analysis

1. Using the Communityville data set, run a Suitability Analysis using the Suitability Wizard, creating two suitability factors and making the factors weighted:
   - Proximity to wetlands using lower suitability scores with closer proximity to wetlands
   - Proximity to nests using lower suitability scores with closer proximity to nests

2. Examine the pie chart in the chart display. What is the relative weighting of the two suitability factors, proximity to wetlands and proximity to nests? Using the variable assumptions, change the weighting of the proximity to wetlands to be 8 out of 10 or 80% and the weighting of the proximity to nests to 2 out of 10 or 20%. Check that these changes are updated on the chart.

3. Open the Properties of the Proposed Buildings layer and go to the Symbology tab. Show Quantities → Graduated colors, and select Suitability as the Field.
   
   Click on the heading called Symbol in the table and select Properties for all symbols. Select a symbol called Square 1 and change the symbol size to be 12.00. Click OK. All of the symbols in the table will be black squares.
   
   Now select a green to red color ramp. The higher values which represent more suitable sites should be green and the lower values should be red. If they are not, then click on the Symbol column in the table and select Flip Symbols. This will reverse the order of colors. The symbology table should look like the one displayed here.

   Click Apply and look at the map. Do the results make sense?

4. Now run the Common Impacts Wizard, deselecting the impacts affecting commercial areas, of which there are none in this analysis. Otherwise accept all of the defaults and click Finish.

5. On the 360 Analysis tab, click on Reports. There is a report listed called "Communityville Common Impacts." Double-click on it to open it. Examine the contents displayed in the report. Notice that it is being displayed in your browser and that it was saved in HTML format so that you can display it on a website it you like.

6. Change the Active Scenario to Rural and examine the map. Change it back to the Village scenario.

7. Change the Chart display to be Compare by Scenario.
8. **Note:** If you want to return the map to its original appearance, go back to the *Symbology* tab of the *Layer Properties* window and change it to *Show: Categories → Unique Values*, selecting "Suitable" for the Value Field. Click on "Add All Values" below the table, and then modify each symbol by double-clicking on it to open the "Symbol Selector" window. Change the symbol with the value of 0 to be a red square and the symbol with the value of 1 to be a green square. You can select the shape and size first and modify the color after. Click "Apply" at the bottom right of the Layer Properties window to see if you like the results.

**Organizing and displaying analysis information**

9. Click the *Organize* button above the charts and change the order of the charts to be as follows for the top several charts:

<table>
<thead>
<tr>
<th>Chart</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population</td>
</tr>
<tr>
<td>Residential Dwelling Unit</td>
</tr>
<tr>
<td>Residential Energy Use</td>
</tr>
<tr>
<td>School Kids Population</td>
</tr>
<tr>
<td>Residential Water Use</td>
</tr>
<tr>
<td>Road Cost</td>
</tr>
<tr>
<td>Labor Force Population</td>
</tr>
<tr>
<td>Vehicle Trips per Day</td>
</tr>
<tr>
<td>Annual CO₂ Auto Emissions</td>
</tr>
<tr>
<td>Annual CO₂ Auto Emissions</td>
</tr>
</tbody>
</table>

Close the Organize Charts window, and examine the chart display.

10. Why does the village scenario have a much higher total **household energy** usage than the rural scenario?

   What is the **population** of each scenario? Given the populations, which scenario has a higher **cost of building roads per person**?

11. Examine the chart displaying the **Annual CO₂ auto emissions**. Which scenario currently would emit more CO₂ auto emissions, the rural or village scenario? Once you have determined the answer, click on the **Assumptions** icon on the **360 Analysis** tab, and **change** the assumptions for each of the scenarios to the following, clicking the **apply** button when done:

   **Village Scenario**
   - Vehicle Trips per Day → to 8.0
   - Average vehicle trip length → to 3.0 miles

   **Rural Scenario**
   - Vehicle trips per day → to 10.0
   - Average vehicle trip length → to 12.0 miles

   Examine the charts. How does the **annual CO₂ auto emissions** compare by scenario now that you have changed the **vehicle trips per day** and **average vehicle trip length** for the rural and village scenarios?

**Creating and using saved views**

12. Arrange the view to look approximately like that below.
13. Once you have your analysis set up, create a saved custom view of your current display by clicking the 360 Analysis tab Saved Views icon (see right) or by clicking the Open or Save a View toolbar button at the top of the screen. Then simply click the Save Current View button and enter a name for it, such as "Village Suitability Analysis."

This saved view is a snapshot of the screen as it is displayed right now that you can call up in Scenario 360 at any time, and can be used to illustrate different scenarios to community members.

To view previously saved views, simply click on the Saved Views button and select from the list.

Creating a web-ready report

Now you will generate a professional report ready for hard copy publication or web site posting. Reports are generated in HTML format, immediately ready for hard copy publication or web site posting.

The Reports Wizard will guide you through the reports process, allowing you to customize your report.

Scenario 360 web-ready reports are now more flexible, allowing the viewer to customize the report in real time and providing for charts that compare all scenarios in an analysis.

1. Click the 360 Analysis tab Reports icon or click the List Reports toolbar button.
2. Click the New Report button.
3. Choose the "Detailed scenario comparison" (see figure below)
4. The Reports Wizard will guide you through the reports process, allowing you to customize your report. For this tutorial, accept the default settings. This will require you to leave many fields blank, selecting Next as you move through the steps.
5. Completed reports are saved in the analysis folder Reports directory. Within the Reports directory, all pictures included in your report (such as charts and maps) are saved in an Images folder. You can import these images into any presentation or document (including PowerPoint presentations and Microsoft Word documents).

6. When you are finished with your report, you will be returned to the Reports window. Click on the name of your new report (the default name is Communityville Scenario Comparison) to open it. This report is a stand-alone file that you can copy and share with friends.

**Note:** Within the Reports directory, all pictures included in your report (such as charts and maps) are saved in an Images folder. You can import these images into any presentation or document (including PowerPoint presentations and Microsoft Word documents). Its default location is:

C:\CVFiles\Communityville\Reports\Communityville Scenario Comparison\Report.htm.

7. When you are finished, close ArcMap and Discard Changes.

**Creating WebShots**

This section will take you through the steps of creating WebShots. WebShots are HTML files preserving snapshots of your analyses that you can display on a website as a slide show or in a partly interactive format. Viewers of the interactive website can change scenarios with a limited ability to change assumptions and see the results. The web pages produced by WebShots allow viewers to see your analysis in two modes:

- **Slide show mode** displays a series of screen images in the order you specify
- **Explore mode** allows viewers to choose the scenario they are viewing and to vary assumptions.

It is important to run the WebShots Wizard after having created all the scenarios and variable assumptions you think you will use, as the Wizard does not detect any analysis changes made after it has been run; you will need to run it again if you do more analyses.

The WebShots Wizard will let you choose:
- Up to 5 scenarios to display
- Up to 5 assumptions that you will be able to vary
- Up to 5 discrete settings for each variable assumption (in addition to its default setting)
**Assumption values** that are not varied in your WebShots display will be **fixed** at the values they have when you start the WebShots Wizard, even if they are variable assumptions. Therefore, you should **set them to the values** you want to use before starting the wizard.

First set up your screen the way you want it to appear on the web in terms of the map **symbology** and which layers are on or off.

The exercise below provides you with an example of how you might set things up using the Suitability and Common Impacts analyses you just ran on the Communityville data set.

1. If the Communityville data set isn’t already open, go to the Scenario 360 menu, point to Analysis, and select **Open** and choose the Communityville data.

2. Make sure that the Active Scenario is the Village Scenario. Zoom out until the squares representing the houses are not touching each other.

3. [On the **Scenario 360** Analysis tab, click on Assumptions. Change the **Bird Nest Setback** to **400 feet** and click on the **Apply** button. This means that sites located closer than 400 feet to nests of particular bird species are not considered suitable. Select "**Yes**" for the assumption called "Prohibit Building in Wetland Areas." ]

4. Click the **Scenario 360** menu, point to **Presentation**, and click **WebShots Wizard**. [If the WebShots Wizard is grayed out or disabled, see CommunityViz help for the conditions necessary for it to be enabled.]

5. The **WebShots Wizard** prompts you for various settings and preferences. If in doubt about what information to provide on any given screen, simply click **Next**. You will receive a helpful message if more information or different information is needed. For detailed information on the required settings, see WebShots in the help.

6. In the WebShots Wizard, click **Next**, and then choose both the village and rural scenarios. Click **Next**.

7. Choose all three assumptions. These will be variable, and viewers will be able to change one assumption at a time while other assumptions are set to default values. Click Next twice.

8. When the first window entitled "Choose Discrete Settings for Assumptions" appears, note that True and False are already in the WebShot Value(s) box on the right for the assumption "Prohibit Building in Wetland Areas." Click Next.

9. For the Water Tank Site, select Sites A, B, and C, and respectively click on the green arrow pointing to the right to select these as WebShot values. Click Next.

10. For the Bird Nest Setback, enter 200 (ft) in the left-hand box and click on the right-pointing green arrow to include this as a WebShot value. Do the same with 400 and 600. Click Next.

11. On the window entitled "Choose Web Shots," leave the Slide Show boxes blank, selecting only the "Explore" boxes. Click "Next" and then "No" when a dialog box appears asking if you want to create Slide Show slides.

12. Click "Next" six times, accepting the defaults for each window that comes up. Then click "Finish."
Congratulations – you have completed Tutorial 6
This tutorial has taken you through a sample build-out analysis using Scenario 360. You have set up and run numeric, spatial, and visual build-out on this analysis.

Tutorial 7 - Exporting Analyses to Google Earth™
This tutorial will walk you through exporting an analysis for 3D viewing in Google Earth, exporting TimeScope build dates so you can look at changes over time in Google Earth, and exporting your analysis with 3D models from the CommunityViz KMZ Model Library or any other KMZ model. The 3D scene will open up to its proper global location as represented by satellite images, with your scenario displayed in three dimensions and your charts displayed in a window. Most feature layers will be automatically “draped” on the Google Earth terrain. The files you export will be in Google Earth’s .KMZ format which can be freely shared with others so they can view it in Google Earth as well.

Requirements
You must have installed Google Earth 4 or later onto your computer in order to take advantage of all of the features described here. A high-speed Internet connection is also recommended. Google Earth is an independent application that must be installed separately. Information is available at earth.google.com.

Exporting an analysis to Google Earth – the basics
1. Open the Sunny Vista analysis.
2. Click on the Scenario 360 toolbar menu » Presentation » Google Earth Export Settings.
3. On the General tab, note the default path name for the .KMZ file that Scenario 360 is about to create. (For future reference, you can change the file name or location by clicking the Browse button.)
4. Go to the Scenarios tab. Choose to export both Proposal A and Proposal B.
5. Go to the Layers tab. To specify which layers to export, place a check by their name in the list on the left. To set up particulars of how each layer will be exported, highlight its name in the list and then provide settings in the panel on the right. For this exercise, check the following layers: streams, ponds, contour lines, roads, elk grazing habitat, parcels, and 3D Buildings.
6. Click on the 3D Buildings layer so that it is highlighted and selected as the current layer.
7. Change this layer's "Export Layer As" setting to "Extrude Polygons" rather than "Geometry." Note that this is only possible with polygon layers (not points, lines, or rasters).
8. Change the color to one that you think would be suitable for a building.
9. Select “Enter height manually” and change the height to 12 m. This is the height to which all the buildings will be extruded. (For future reference, you can use a height attribute in the layer instead.)
10. Go to the Charts tab. Select two or three charts that you would like to export to Google Earth.
11. Click the Export Now button.

Google Earth will launch and take you to the location of Sunny Vista.
12. Use the Places list to determine which scenario you are looking at: A or B. Change to the other scenario and experiment with selecting and deselecting layers.
13. Move your mouse to the upper-right corner near the North arrow, and two slider bars and a rotating dial will appear. Use these to change your viewing position of the scene. The vertical slider changes the proximity to the scene and the horizontal slider changes your viewing height or viewing angle of the scene. Use the dial to change the direction of view.
14. Right-click on the 3D Buildings layer and select Properties. Click "OK," choose the Style, Color tab, and click on the color box. Select a different color and click 'OK.' Notice that the color of the buildings changes. Click 'OK.' With the 3D Buildings layer still highlighted, try moving the slider bar at the bottom of the Places list to make the extruded buildings partly transparent.
15. Below the scenarios in the Places list, expand the Charts folder and select one chart at a time to display. (Selecting the entire Charts folder will simply display all charts on top of one another, which is not recommended.)
Exporting TimeScope™ build dates to Google Earth

In this part of the tutorial you will be guided through exporting TimeScope build dates to Google Earth, where you will be able to visualize future scenarios as they change through time by using Google Earth Timeline.

Exporting TimeScope build dates to Google Earth

1. Open the Sunny Vista analysis in Scenario 360 if it is not already open.
2. Run TimeScope, selecting the Buildings layer, accepting the default start and end dates, and choosing linear growth. Accept all of the defaults, clicking Next as needed and then Finish to run TimeScope.
3. In the ArcMap Table of Contents, expand the Build-Out layer and right-click on the Buildings layer to Open Attribute Table. Make sure that the attribute called TS_BUILD_DATE exists in the attribute table. Close the table.
4. Go to: Scenario 360 toolbar menu > Presentation > Google Earth Export Settings.
5. Go to the Scenarios tab. Choose to export both Proposal A and Proposal B.
6. Go to the Layers tab. Deselect any layers you don’t want to export, such as the mask, or area boundary.
7. Click on the Buildings layer and select Export Layer as: Geometry.
8. Click the TimeScope tab. Any layers for which you have run TimeScope will be displayed. Select the Buildings layer which has a TimeScope build date attribute (TS_BUILD_DATE). If you do not see any layer names displayed, you may have skipped a step.
9. Go to the Charts tab. Select the charts that you would like to export to Google Earth.
10. When you are ready, click the Export Now button.
11. Move your mouse to the upper-right corner near the North arrow, and two slider bars and a rotating dial will appear. Use these to change your viewing position of the scene. The vertical slider changes the
proximity to the scene and the horizontal slider changes your viewing height or viewing angle of the scene. Use the dial to change the direction of view.

12. Notice the Timeline slider bar adjacent to the other slider bars. To mimic the behavior of a moving the TimeScope Time variable assumption slider bar in Scenario 360, set the Timeline’s left-hand slider to the current year and move the right-hand slider into future years. Notice that Google Earth Timeline allows you to display or hide features on the image according to their TimeScope build date.

[Image of Google Earth Timeline]

Using KMZ models in Google Earth™

In this part of the tutorial, you will learn how to use existing 3D models in KMZ format to represent buildings, trees or other map points in your Google Earth scene. KMZ models are available in the CommunityViz KMZ Model Library (included with your software), or in Google's 3D Warehouse (sketchup.google.com/3dwarehouse/). You can create your own models using Google's free software SketchUp® (sketchup.google.com).

1. Still in the Sunny Vista analysis, go to: Scenario 360 toolbar menu › Presentation › Google Earth Export Settings.

2. Go to the Layers tab, click on the Buildings layer in the list, and choose “Export Layer As: 3D Models.”

   **Note:** Only point layers can be exported as 3D Models.
3. Choose “Select a random 3D model from a list.” Using the Browse for Model Files button, go to C:\KMZ Model Library and choose a house model. (For future reference, if you have more than one model, you can add all of them here. Scenario 360 will choose a random model for each point.) Once you have found a model, click Open.

4. If desired, you can orient (turn) your model so it faces a particular direction such as towards the nearest road by entering an orientation (in degrees) manually, or by referring to a numeric attribute in the point layer.

Advanced tip: you could write a simple dynamic attribute formula using the AngleTo function that gives the angle to the nearest road, and then use that as an orientation field.

5. Click on the Export Now button and Google Earth will be launched. If you select the Buildings layer to be displayed, your new model will appear.

Note: You can specify Google Earth models in the Visual portion of the Scenario 360 Build-Out Wizard if desired. After doing so, choose “Get 3D model file from a field” in the Layer export settings and choose the attribute field called “3D Model.”

Using SketchUp and 3D Warehouse models
In addition to the CommunityViz KMZ Model Library, you can obtain 3D models from Google’s on-line 3D Warehouse or you can make your own using Google SketchUp. For either of these options, you will need to download and install SketchUp from www.sketchup.google.com.

1. Go to the Google Earth 3D Warehouse at:

   http://sketchup.google.com/3dwarehouse/

   This is a site that hosts three-dimensional images that are posted by members of the public. Search for a house of the Cape Cod style by typing "Cape Cod" in to the search engine and clicking "Search." Select a house by double-clicking on it, and then click the Download to Google SketchUp button. When you are prompted, select Open with Google SketchUp rather than Save to Disk.

   - OR -

   Create a model of your own in SketchUp. Follow the directions within SketchUp or their tutorials.

2. Once your selected 3D Warehouse model has been opened up in SketchUp or you have created your own model in SketchUp, export your model into Google’s .KMZ format so that it can be imported into Google Earth. Normally models are saved in SketchUp as .SKP files. To export the file, go to the SketchUp menu and choose File > Export. Save it as a Google Earth 4 *.KMZ file in your analysis directory or in your local KMZ Model Library. Examples:

   C:\CVFiles\3D Models\KMZ\CapeHouse.kmz
   -or-
   C:\CVFiles\Sunny Vista\3D\GoogleModels\CapeHouse.kmz.
On your own, try resetting the Buildings layer export settings to use the Cape House, and see how it looks!

When you are finished using Google Earth, close the window and, when asked whether you want to save items to your “My Places” folder, answer No.

**Congratulations – you have completed Tutorial 7**

This tutorial has taken you through exporting a scenario to Google Earth, exporting TimeScope build dates to Google Earth, and using a SketchUp 3D model to represent points in the Google Earth scene.